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Safety Precautions and

This manual contains warnings, which you should note for your own safety as well as
for the prevention of damage to property. These warnings are indicated by means of a

indicates that loss of life, severe personal injury or substantial damage can result if proper

indicates that minor personal injury or property damage can result if proper precautions are

call attention to information that is especially significant to the product, handling of the

The equipment may be commissioned and put into operation by qualified personnel only.

Warnings
triangle and displayed as follows in accordance with the level of danger:
Danger
indicates that loss of life, severe personal injury or substantial damage
will result if proper precautions are not taken.
Warning
precautions are not taken.
Caution
not taken.
Notes
product or a specific part of this documentation.
Qualified
Personnel

For the purpose of safety relevant warnings of this manual a qualified person is one who is

authorized to commission, ground and tag devices, systems and circuits.

Use as prescribed Please note the following:

Warning

This equipment must only be used in applications as prescribed in the catalogue and the
technical description and in conjunction with equipment and components recommended

and authorized by Siemens.

Successful and safe operation of this equipment is dependent upon proper transport, and
storage, erection and installation as well as careful operation and maintenance.
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The other brand names in this manual may be trademarks use of which by third parties for

their purposes may infringe the proprietors’ rights.
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registration of a utility model or design, are reserved.

Siemens AG

Industry Sector

Industry Automation Division / Industrial Automation Systems
Factory Automation

IIAASFAWFFTH 1

Postfach 23 55, D- 90713 Firth

Exclusion from Liability

W e have checked the contents of this document with regard to
conformity to the described hardware and software. Deviations, however,
cannot be excluded; therefore we cannot accept prejudice for its
complete conformity. The information in this document is checked
regularly and necessary corrections are contained in subsequent issues.
Any suggestions for improvement are gratefully received.

W e reserve the right to make technical changes.



Preface

Preface

Purpose of the
Manual

Contents of the
Manual

Scope of this
Manual

How to Access the
Information in this
Manual

The information in this manual allows you to set up and put in operation the
connection between the CP 443-1 in an S7 redundant system and a device
that supports the Open MODBUS/TCP protocol.

This manual describes the function of the Modbus function block and their
integration into the hardware and software of the communication processors
CP 443-1.

The manual contains the following topics:

¢ Production description

e Getting Started

e Commissioning / Installation / Parameterization
e Licensing

e Function blocks

¢ Diagnostics

e Application sample

This manual is valid for the following software:

Product Identification number | From version
MODBUS/TCP Redundant 2XV9 450-1MB11 211

FB 909 ,MB_REDCL" 24

FB 908 ,MB_CPCLI* 2.3

FB 907 ,MB_REDSV* 2.3

FB 906 ,MB_CPSRV* 2.2

Note

This manual contains the FB description, as it is valid at the time of
publication.

To enable you a quick access to selected information, the manual provides
the following access aids:

e The next pages contain a complete table of contents.

SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems 1
2XV9450-1MB11; Manual edition 2.2
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Additional
Sources of
Information

Additional
Questions

Terminology

All additional information concerning CP 443 (mounting, commissioning
etc.) can be found in the manual

SIEMENS

SIMATIC
Fault-Tolerant Systems
S7-400H

System Manual
A5E00267693-03

SIEMENS

SIMATIC NET

S7-CPs for Industrial Ethernet
device manual
C79000-G8900-C155

SIEMENS

SIMATIC NET

S7-CPs for Industrial Ethernet
device manual part B4

CP 443-1
C79000-G8900-C152

SIEMENS

SIMATIC NET

NCM S7 for Industrial Ethernet
manual C79000-G8900-C129

Additional information concerning STEP7 can be found in the following
manuals:

SIEMENS

SIMATIC Software

Base software for S7 and M7
STEP7 user manual
C79000-G7000-C502-..

SIEMENS

SIMATIC Software

System software for S7-300/400

System and standard functions

Reference manual C79000-G7000-C503-02

If you have further questions regarding the use of the FBs described in this
manual, which are not answered in this document, please contact your
Siemens partner who supplied you with this function block.

This document uses the term CP or CP 443. The descriptions only apply to
communications processor CP 443-1.

Scope of The function block described in this manual establishes a connection
Application between the CP 443-1 and third party MODBUS devices.
SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems 2
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Product Description

1 Product Description

1.1 Field of Applications

Placement in the
System Environ-
ment

Function of the
FBs

TCP/IP with
CP443-1

The driver described here is a software product for the Communications
Processor CP443-1 in a SIMATIC S7 redundant system.

CP 443-1 can be used in the SIMATIC S7-400 automation systems and can
establish communication links to partner systems.

These function blocks enable a communication link between CP 443-1 and a
device that supports the Open MODBUS/TCP protocol. The function codes 1,
2,3,4,5,6, 15 and 16 are provided.

Data transmission is carried out following the Client-Server principle.

The SIMATIC S7 can act as both client and server during the data
transmission.

Redundant communication is supported. A S7-400H system as well as a
S7-400 single CPU with 2 CPs can be used.

Hot standby means the parallel redundant processing of signals in redundant
components. This allows a bumpless failover of the entire system to the
standby components.

TCP/IP with CP443-1 uses static connections. The TCP connection is not
disconnected during operation.

Network configuration of STEP7 enables only a unique use of a specific
port number, when using TCP native stack of the CP.

However, with specific CP modules it is possible to use multiple connection
via port 502 to different clients simultaneously.

In section 3.6 “Mulitple connections via port 502" you can find technical
details regarding this matter.

SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems 11
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Product Description

1.2 Hardware and Software Prerequisites

Usable Modules
for MB_REDCL
and MB_REDSV

Software Versions

Memory
requirements

The block AG_CNTRL of the SIMATIC_NET library permits to terminate and
reestablish an established connection. This block was also implemented in
the Modbus blocks for a more effective use of the resources of CPU and CP.
However, previous CPs or previous firmware releases do not support the use
of AG_CNTRL.

Here you can find up-to-date information which CPs and which firmware
releases support AG_CNTRL: Ethernet CPs and AG_CNTRL.

You can find further hardware prerequisites on the internet:
www.siemens.com/s7modbus

The usage of the FB MB_REDCL and MB_REDSYV is possible with STEP7
Version 5.4 or higher. Withal the use of the blocks AG_LSEND/AG_LRECV
V3.1 of the update of SIMATIC NET library
(http://support.automation.siemens.com/WW/view/de/22172239) is required.

The FB MB_REDCL requires 14 kByte work memory and 17 kByte load
memory.

The FB MB_CPCLI requires 10 kByte work memory and load memory.

The FB MB_REDSV requires 12 kByte work memory and 14 kByte load
memory.

The FB MB_CPSRYV requires 10 kByte work memory and load memory.

You can find precise length information of the blocks in their properties in
SIMATIC Manager.

SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems 1-2
2XV9450-1MB11; Manual edition 2.2
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Getting Started

2  Getting Started

Procedure Install “SIMATIC Modbus/TCP Redundant®.
=> Section 3.1
Parameterize the connection parameters regarding your requirements
(IP-address, port number, etc.).
=> Section 3.2 and 3.3
Insert the Modbus function blocks into your SIMATIC project.
=> Section 3.4
Modbus Client: Call and parameterize the Modbus block MB_REDCL in
the required OBs.
=> Section 5.2 and 5.3
or:
Modbus Server: Call and parameterize the Modbus block MB_REDSYV in
the required OBs.
=> Section 6.2 and 6.3
Load the user program into the PLC and license the Modbus block for this
CPU.
=> Section 4
SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems 2-1
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Commissioning

3 Commissioning

General
Information

Requirements

3.1 Installing the

What We Provide
You

Requirements

The configuration of the CP 443-1 is possible via MPI or LAN/Industrial
Ethernet. Required software is STEP7 with NCM S7 for Industrial Ethernet
(shortly named "NCM IE").

All statements in the following sections referring to STEP7 or NCM IE are

related to the STEP7-Version 5.4 SP3 and NCM S7 Industrial Ethernet
Version 5.4.

Operation flows, names and directory names might be different in other
STEP7 versions.

Knowledge of AWL and basic knowledge of STEP7 and PLC.

Library on the STEP7 PG/-PC

The attached CD contains a setup, which installs the library
“Modbus_TCP_CP_Red300_400", the example projects and the manuals in
English and German in the corresponding STEP7 directories.

The manuals can also be found on the CD as PDF file.

To install, STEP7 must be installed.

Installation Insert your Modbus CD into the CD-ROM drive and follow step-by-step the
instructions that are automatically displayed by the installation program. If the
installation program fails to automatically run, perform these steps:

1. Using Windows Explorer, navigate to the CD-ROM drive and go to the
directory setup and double-click to the setup file to start the installation
procedure.

2. Follow step-by-step the instructions that are displayed by the installation
program.

Now you can find

e the libraries in \Program Files\Siemens\Step7\S7libs,

¢ the example projects in \Program Files\Siemens\Step7\Examples,

e the manual in \Program

Files\Siemens\Step7\S7manual\S7Comm.
o the Software Registration Form in
\Program Files\Siemens\Step7\S7libs\ Modbus_TCP_CP_Red300_400.

To access the Modbus library the first time, use the browse function of the

open dialog for libraries.

The manual can be accessed via short cut in \Program Files \Siemens

\Documentation as well.

SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems 3-1
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Commissioning

3.2 Parameterization of the CP

Parameterization
of the CP

Parameterization
of the
Communication
Partner

If you have your stations connected with each other without a router, then
they have to be within the same subnet.

In the field Subnet connect the CP with the Industrial Ethernet. In order to do
that, select the entry with the name of your network. For newly created
networks this is normally “Ethernet(1)".

Properties - Ethernet interface CP 443-1 (RO/55) 1[

General  Parameters |

[” Set MAC address / uze IS0 protacal
MAL address: I

V| 1P protocal is being used

Gateway
IP addiess: 10.0.0.41
aadEss % Do ok s router
Subnet mask: 255.0.0.0
" Use rauter
Address: 10000041
Subnet:
- niot networked - N Mew... |
Ethernet(1
Properties... |
Ethemet{4]
Etherneti5] hd| &I
el |__tob_|

Save and Compile the parameterization.

In the mode “CP is client” an “other station” is required for network
configuration.

After you have inserted the communication partner’s station into your STEP7
project you have to specify the object properties of the external station.

1) Properties — Other Station > Interfaces

On the tab “Interfaces” click on “New". In the upcoming selection, select
“Industrial Ethernet” and click on “OK”.

Properties -Dther station x|

General  Interfaces |

Mame | Type | Address ‘ Subnet |
New Interface - Type Selectio x|

Tupe: Industrial Ethernet
MP

Mew.. Delete |
QK I Cancel Help |

Ok | Cancel Help
SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems 3-2
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Commissioning

This opens a dialog box “Properties — Ethernet Interface”. Enter an IP
Address that is in the same subnet as the communication partner’s station.
The subnet mask should be the same as the one of the partner’s station.
Select the associated subnet that connects the CP interface with the
communication partner’s interface.

Properties - Ethernet interface x|

Gerneral  Parameters I

[ Set MAC address / use 150 protocal

MAC address: I If & subnet iz selected,

the next available addresses are suggested.

¥ | IP protocal is being used

IP address: 10.0.03 Gateway
| {* Donotuse router
Subnet mask: 255.0.0.0
 Use router
Address: |1 0.0.0.31
Subnet:

— not networked - - MNew... |
Ethernet[1

Froperties... |

Etherret(5] LI Delete |

Cancel | Help |

Click on the “OK*" button. This will bring you back to the tab “Interfaces".

Properties -Other station ﬂ
General  Interffaces |
MName | Type | Address | Subnet |
Ethemet port(1] Industrial Ethernet 10.00.31 Ethernet[2]
Mew... Froperties... [relete |

] 4 | Cancel Help

2) Properties — Other Station>»General

In tab “General” you do not have to make any settings.

SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems 3-3
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3.3 Network Configuration

Communications
Connection

Configure Network
in mode “CP is
Client”

The CP is the link for the Industrial Ethernet connection between the S7-CPU
and the communication partner / bus. A connection configuration must be
made for the connection of the interfaces to the communication partner / bus.

In the STEP7 project, select the CPU in your S7400H-Station and open
“Network configuration“ by double clicking “Connections”. This opens the
program “NetPro“ with which your connections can be configured.

After selecting Insert>» New Connection... the dialog box "Insert new
connection” will come up.

E‘,}_%Netpro - [MODBUS_TCP_CP_Redundant {(Network) -- E:%Program Files'...\Examples’MODBUS_
%@ Metwork Edit  Insert PLC Wiew Options ‘window Help

S80S e dalbdgLImEa ! v

Ethernet(1)
Industrial Ethernet

| L]

H Single-sided (Client)

| |Qther station{Server1)

7 | CRU | OF | MPLDF |CF
r||||| Hi-i ! i T8
H H
[ | =]
00
| |
Local &

Chrl+M

Download selecked conneckions

Show/Hide Columns 3
Cptimize Column Wwidth
Display Columns. ..

Select the connection partner (Other Station) for the new connection and use
“TCP Connection” for the connection. Put a check mark on “Show properties
dialog“.

SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems 3-4
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Object Properties
of the Connection

SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems

Insert Mew Connection

— Connection Parther

EI--@ It the curment project
EI@ MODBUS_TCP_CP_Redundant
Bl H Double-sided [Client)
: H Double-sided [Server)
+ E H Single-zided [Server]
8 ik s erl)
5 Other station[Server2]
- [Unzpecified)
- gl broadeast stations
feeee B multicast stationg
% It unkhown project

Preject: [MODBUS_TCP_CP_Redundant

£

Station: IDther station[Server])

el oduafe: |

— Connection

Type: I TCP connection

v Display properties before inserting

=

ok | ey |

Cancel |

Help |

Click “OK". This will take you back to the dialog box “Properties TCP

connection®.

e An ID is provided. You can change the ID if needed.
e Click on the button “Routing” and the configured connection will be shown.
e The MODBUS client does “Active connection establishment”.

Properties - TCP connection

General Information I Addresses IDptionsI Dwerview

— Local Endpaint

— Block Parameters

Status Infarmation I

X

10 [hes): 0001 A051 1
Mame: ITEP-Verhlndung-48 W GH1FF7—ILADDR
‘ia CP: |EF' 4431 - [ROAST)
Boute... |
W &ctive conmection establishment
Cancel Help

2XV9450-1MB11; Manual edition 2.2
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Selection of the
Port Number

¢ Inthe register “Addresses” the port humbers are defined.

Properties - TCP conneckion i =l
General [nfarmation Addresses I Dptionsl Owerview Statusz Infarmation I
Ports from 1025 through 65535 are available.
[Far further parts, refer ta anling help)
Local Remote
I (dec) [iD0nsn [ioonen
FORT [dec]: |m |502

Click on “OK" and the inputs are accepted.

Save the network configuration and close the program “NetPro”.

Please note that the connection ID (Local ID) has to be used when the FB is
called in the user program.

In a MODBUS communication a MODBUS server are normally addressed via
port 502, whereas a MODBUS client uses a port from 2000.

SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems 3-6
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Unspecified
Connection with
“CP is server”

If you have got a communication with CP as MODBUS server, the
communication is set up as “unspecified connection”. The client has to meet
the requirement of active connection establishment.

After selecting Insert>» New Connection... the dialog box "Insert new
connection” will come up.

t‘&NetPro - [MODBUS_TCP_CP_Redundant {Metwork) -- E:Program
%@ Mebwork  Edit  Insert PLC  Wiew Options Window Help

S § S 2edadl S dL[EE ! N

Ethernet(2]
Industrial Ethernet

| I

H Single-zided (Server)

TMFVDR[GE JCRU (OR MPLDR [CP
! W H ' HH
1 o H
=] =] = | =]
2 20 20 0
4
Local I Partner IT Partner

nnection Chrl-+M

Download selected connections

Show/Hide Columns 3
Optimize Column Width
Display Columns. ..

Select here “unspecified” instead of the communication partner and use
“TCP Connection” for the connection. Put a check mark on “Show properties
dialog"

Insert New Connection : il

r— Connection Partner

EI--{E| I the curent project

EI@ MODBUS_TCP_CP_Redundant
F-{fll H Double-sided [Client)
[]—- H Double-sided [Server)
[]--E H Single-sided [Client]
Other gtation[Server)

----- 5 Other station[Serverz]

[Unspecified)

All broadcast stations
------------ All multicast stations
% Ih unknown project

x
Eraject: | <
Station; I[Unspecified]
odule; |
— Connectian
Tupe: ITEIF‘ cohhection j

¥ | Display properties before inserting

ak, I Apply Cancel | Help |

SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems 3-7
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Click "OK". This will take you back to the dialog box “Properties TCP

connection“.

The check box “active connection establishment” must not be activated.

Properties - TCP connection

General Infarmation I Addresses IDptionsI Owerview | Status Information I

— Local Endpaint

10 [hes):
Hame: ITEP-Verhindung-E?
‘ia CP: |EF' 4431 - [ROAST)

Boute... |

[ Active connection establishment

I~ Use ETF protocal

— Block Parameters

1—ID

WHIGHIFFY —LADDR

X

Cancel | Help

In the register “addresses” all information regarding the partner, “IP” and

“PORT” are left blank.

Properties - TCP connection

General [nformation Addresses IDptionsl Owerview Statusz Infarmation I

Forts fram 1025 through 65535 are available.
[Faor further ports, refer to online help)

Local Remote
IF [dec): |1 0.0.0.50 I
PORT [dec): |502 |

|

Cancel | Help

Click on “OK" and the inputs are accepted.

SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems
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3.4 Insertion of the Function Blocks into the Program

Content of
MODBUS library

S7 400 Client

S7 400 Server

The Modbus library contains the folders ,S7 300 Client”, ,S7 300 Server*,
.S7 400 Client* and ,S7 400 Server* with the FBs for the redundant
communication.

The folder “S7 400 Client” contains the blocks
e FB909 (MB_REDCL) and
e FB908 (MB_CPCLI)

amongst others.

% Modbus_TCP_CP_Red300_400 (Component view) -- C:\Program Files{SIEMED i [m] B3
E@ tModbuz TCP_CP_Red300_400 Object name | Svmbalic name Created... | Type | Yerzion ...

E2-(E §7 300 Client £FFEA0S  MB_CPCLI 5CL Function Block 2.3

B-(E0) 57 300 Server Z3FEI03  MB_REDCL 5CL Furiction Black 2.4

(20 57 400 Client o DB3 LCENSE_DE DB DataBlock 0.1

ﬁ Elocks

&3 574005 |

B-{z5] erver - ]

Both blocks are required for redundant communication. The function block
MB_REDCL executes a multiple call of MB_CPCLI.

The folder “S7 400 Server* contains the blocks
e FB907 (MB_REDSV) and
e FB906 (MB_CPSRV).

amongst others.

“zModbus_TCP_CP_Red300_400 {Component view) -- E:"-.IPrugl!.anﬁ'_ 1l ENS'. ST = |D|ﬂ
E-§ Modbus_TCP_CP_Red300_400 | | Object name | Symbolic name | Created. | Type | ersion ..
B-{z2] 57 300 Client &FFEA0E  ME_CPSRY SCL Function Block 2.2
B (g1 57 300 Server Z3FBI0F  ME_REDSY 5CL Function Block 2.3
E-E8 57 400 Client - DB3 UCENSE DE DB DataBlock 01
EE] 57 400 Server
ﬁ : _’I

Both blocks are required for redundant communication. The function block
MB_REDSV executes a multiple call of MB_CPSRV.
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Insertion of the Open the library “Modbus_TCP_CP_Red300_400" and copy the necessary
blocks blocks. Insert the blocks into your program.

The Modbus function block uses the function blocks AG_LSEND and
AG_LRECV. Copy these functions from the library “ SIMATIC_NET_CP* ->
“CP 400" and insert them into your program.

Copy also the function AG_CNTRL from the library “SIMATIC_NET_CP" into
your program.

Please note, that the following versions of the FCs are a prerequisite for the
faultless function of the FBs MB_REDCL/MB_REDSV:

AG_LSEND V3.1 or higher
AG_LRECV V3.1 or higher
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3.5 Multiple Connections via Port 502

General

Pre-requisits

Number of
released
Connections

Displaying the
Status of the
Connection

Characteristics of
the Error Handling

Tip for your User
Program

Some CP modules are able to multiplex TCP connections. In doing so
several Modbus clients can establish a connection via port 502. The CP acts
as Modbus server.

Here you can find information which CP and which firmware release support
multiple connections via port 502:
www.siemens.com/s7modbus

To use the functionality, the parameterization must be carried out as follows:
e CPisserver
e port 502 as local port
e unspecified TCP connection in NETPRO

e passive connection establishment

Please note that only 1 connection is parameterized in NETPRO irrespective
of the number of clients which address the CP as server.

The CP is capable to keep up to 4 connections to different clients.

The status of the connection is displayed even in NETPRO online as well as
in special diagnosis of the CP.

As only 1 connection is parameterized in NETPRO, the display shows the
status of all TCP connections to the several clients.

As long as no client has established a connection “Passive connection
establishment in progress” is displayed.

As soon as one client has established a connection “established” is displayed.
It is not possible to check how many clients have actually established a
connection to the CP.

The FB MB_REDSV and the CP respectively must terminate and reestablish
the connection in certain error situations. This action is carried out by the FB
MB_REDSV. Thereby all existing connections via port 502 are terminated.

When several connections are established via port 502, it is not possible to
identify the client which has sent the recent request.

If the clients use different UNIT numbers, the verification of the same in the
user program allows a determination.

SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems 3-11
2XV9450-1MB11; Manual edition 2.2



Commissioning

3.6  Start_up Characteristics of CP443

Introduction The start up of the CP is divided into the following phases:
¢ Initialization (Power on of the CP)
e Parameterization

Initialization As soon as the CP is connected to power, the hardware self test runs. The
firmware of the CP is set up for operation.

Parameterization During parameterization the CP receives the device parameters that are
assigned to its slot.

The CP is now ready for operation.
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4  Licensing

General The blocks MB_REDCL and MB_REDSV must be licensed for each CPU
individually.
The licensing takes place in two steps: reading the IDENT_CODE and
declaring the registration key REG_KEY. The OB121 must be available in the
CPU.

Please note:
With a S7-H station only the CPU in rack 0 is licensed. Hence the
replacement of the CPU in rack 0 after licensing is no longer possible.

Read the To read the IDENT_CODE please proceed as follows:
IDENT_CODE
1. Parameterize the block MB_REDCL and MB_REDSYV respectively in
the cyclic OB (OBL1 or cyclic interrupt OB) and in OB100 according to
your requirements. Transfer the program to the PLC and turn it to
RUN mode.

2. Open the instance DB of the Modbus block. , Data block” -> ,Open
Online" to open the DB.

Monitoring the block via the button is insufficient.

DB Param - DBI09

Data block  Edit PLC Debug  Wiew Window  Help

Qpen... Chrl+0

Open Orline

Close |
Save Chrl+5 |—
Propetties... —
BNt .. corer |

Prink Presiew. ..
Page Setup...

1 MODEUS_TCP_CP_RedundantiH Single-sided (ServeriCPU 414-4 HY...\DE0O7
2 MODEUS_TCP_CP_RedundantiH Double-sided (ClienthCPU 414-4 H...\DE909
3 MODBUS_TCP_CP_RedundantiH Double-sided (Server)y TP 414-4 HY., \DBIO7
¢ MODBUS_TCP_CP_RedundantiH Double-sided (Client)CPU 414-4 H...\DE100

Exit —
13 220|in  |data_type_2 BYTE Bit16#0 B#16#0
14 240 in db_2 WORD WETERD W1 ER0
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3. The output IDENT_CODE shows an 18 character string

Copy this string per copy/paste from the DB und and insert it in the
form SOFTWARE REGISTRATION FORM. This form is stored in the

library path ..\Program Files\Siemens\Step7\S7LIBS\

Modbus_TCP_CP_Red300_400 during installation and is also

available on the installation CD.
Insert the License-No. of the product package into the form.

@I DB Param - [DB909 — MODBUS_TCP_CP_Redundant'H Single-sided (Client}\CPU 414-4 H... _|O| x|
I Datablock Edit PLC Debug Wiew Window Help ;Iilll
S-H&|o = & BE|IC)! gadh o[ w?
Addres | Decl | Mame Type Initial walue Actual value j
24 B3.0 |in ENG BOOL FALZE FALSE e
25 B4.0 |in DATE_TYVPE BYTE B#16#0 B#16#0
26 B6.0 |in START_ADDRESS WVYORD! Vi1 BR0 i1 6RO
27 B3.0 |in LENGTH WORD atal=r WEERD
28 700 |in WRITE_READ BOOL FALSE FALSE
23 1.0 Jin unim BYTE B#16#0 B16#0
30 720 out | LICENSED BOOL FALSE FALSE
31 21 |out | BUSY BOOL FALSE FALSE
32 722 jout  |DOMNE BOOL FALSE FALSE
33 723 out |ERROR BOOL FALSE FALSE
34 740 out |STATUS_OA WORD tal=r) W B#A090
35 TEO jout  |STATUS_1A WIORD Vi1 B0 i1 B# 2090
36 78.0 jout |STATUS OB WVYORD! Vi1 BR0 Wi GRFFFF
37 800 out |STATUS_1B WORD Wit B0 W BRFFFF
36 820 |out | IDENT_CODE STRING [18] " o PACERE 2 HJ AR MBI
33 1020 |stat | SEMD_BUFFER[1] BYTE Bt 680, B16#0
40 103.0 |stat |SEMD_BUFFER[2] BYTE B# Ej}ﬁ B1E#0 j
] % O
Press F1 for help. @ _l_’_’_ﬂ

Please insert the IDENT-CODE here
The matmal contains information how to find oythe IDENT-CODE.

Bitte tragen Sie den IDENT-CODE hier eil
Das Handbuch enthélt Informationen, wiedSie den IDENT-CODE ermitteln.

== [DENT_CODE <<=

LI
'H L 57-OpenMadbus/TCP

Typz of Soltvware | Softwaretyp: Auniime §aftware

Flease insert the License-Ma. here. Tupeel License/ Lizenztyp: Single Lice pi=
Ty of Use  Art dler R ung: P
¥ou find the License-No. on the package of the pE Vo, Mgl

S lvaare Clags P SoMmarostatue; A
Reference hardware [ Zielharcrare

Bitte tragen Sie die Lizenz-Hr. hier ein
SIMATC PN
L8

Bie finden die Lizenz- Ny auf der Verpackung de

Systern Lond tions | Systemantarce ung
nlrnoas R®

== Licenge-No / Lizenz-Nr <<«

<

Rarratk | Awivtkung
Soliwimre ane electronic docwnentation on CO

Ortier o, { Bestell e - ZRVAREC MBI
e ne Yo, | Rizen b | 209965301 00008

AHS CRIGIMAL INBUSTRIAL SOFTWARE SITMERS SRIGINAL INDUSTRIAL 50|

4. Send this form as Service Request to Customer Support.
Hereupon you will receive the registration key for your PLC.
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Licensing

Declaration of the

The registration key REG_KEY must be declared for each call of the Modbus

Registration Key block.

REG_KEY
The registration key REG_KEY should be stored in a global DB. Via this
global DB all Modbus blocks can receive the registration key (See also the
following example).
Please proceed as follows to declare the registration key REG_KEY:

1. Copy the prepared license block DB3 of the library
“Modbus_TCP_CP_Red300_400" into your project. If the DB number
is already used in your project, rename the license DB.

2. Open the license DB and copy the 17 digit registration key you
received to the column “Initial value”.

ﬁLAD,.-"STL,.-"FBD - [DB3 -- "LICENSE_DB™ -- MDDBUS_TCP_CP_Redund H 5il
{} File Edit Insert PLC Debug “iew Options ‘Window Help
D@ W& 4R v o|tido|Ze | <> O
nddress |Name Type Initial walue Comment
oo STRUCT
|REG_HEY STRINGE[17] 'in=sert REG KEY' JRegistration Hey
END STRUCT

3. Declare the registration key in the data block as “initial value” to
avoid a repeated insertion after reloading the PLC. Open the data
block in the SIMATIC manager with the editor in the declaration view.
Change over to the data view via the menu “View” -> “Data View".
Choose in the menu “Edit > Initialize Data Block” — all values of the
column “initial value” are copied to “actual values”.

4. Assign the value “DB3.REG_KEY” to the parameter REG_KEY of the
Modbus block.

5. Transfer the changed blocks to the PLC. The registration key can be
set at run time. A STOP -> RUN transition is not necessary.

The block is now licensed for this CPU.
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Missing or Wrong When the registration key is missing or a wrong one is detected, the INTF

Licensing LED of the CPU is flashing once per minute. A cyclic error message
regarding the missing license is displayed in the diagnostic buffer, too. The
error number of the missing license is W#16#A090.

FO[™odule Information - CPU417-4H ONLINE 00 =101
Path: |MDDBUS_TEF'_EF'_Hedundant\H-SingIe-si Operating made of the CPU: <> RUM
Statuz: OF Mat a force job
Performance Data | Communica‘tion I Stacks I H State I Identification
General i Diagnoshc Buffer I Memary | Scan Cycle Time | Time System
Ewents: [ Eilter settings active [ Time including CPU Alacal time difference

Time of day Date Ewent
1 i

y i 10  Ewent|D: 168 4090
12:30:46.098 PM 023/03/2M0  Area length emar when reading

2

3 12:29:46.097 P 08/03/2010  Ewent |D: 168 A090

4 12:29:46.097 PM 03/03/200  Area length emar when reading

5 12:28:46.096 P 08/03/2010  Ewent ID: 164 A090

g 12:28:46.096 PM 08/03/2010  Area length emar when reading

7 12:27:46.095 Pk 08/03/2010  Ewent |D; 168 A090

a 12:27-46.095 PM 03032010 Area lendgth emrar when reading ;I
Dietailz on Event: 1of 120 Ewent ID: 1684090

Mo entiy in text database. Hexadecimal walues will be dizplaped. =

Ewent [D: 168 4030

0B: 164 01

P 164 01

DatlD 1/ 2 168 52 C2

Additional infal £ 2 4 3 164 4D4F 4442 B5R3 LI

Save Az | Seftings... | [Hpen Block Help on Event |
Cloge I Update | Frint... | Help |

Warning

The CPU will turn to STOP mode, if the OB121 is not available.

Modbus communication is carried out even with a missing or wrong
registration key, but the outputs STATUS_x is set to W#16#A090 “no valid
license”.
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5 Function Block MB_REDCL — Modbus Client

5.1 Configuration of the Redundant Communication

General
Information

Configuration in

HW Config

Configuration in

NetPro

The CP is client if the S7 takes the initiative to read data from or to write data
to the remote partner.

The communication partner of the H-system can be mounted stand-alone or
redundant, too (single sided or double sided redundancy).

Single sided redundancy Double sided redundancy

H Single-sided (Client)

5 CPU ,DPF  MPLDP
= I Hime ! i
o 1

H Double-sided (Client)
e S| (e
e

cp CPU ,DOF MPLDP
HH L '
H '

cp CPU ,DF MPALDP
[Y=31 [T '
H '

cp
W

‘m m |
] 1 ] 1

Switch Switch

A A B

| |Other station(Server)

| |Other station(Servert) ‘

While configuring the hardware in HW Config, both CP0O and CP1 get
different input and IP addresses, so that they can be addressed unique in the
S7-program respectively from the communication partner.

You have to define one connection in NetPro for each possible connection
between the communication partners.

With single sided redundancy, there is one connection for CPUO/CPO and
one for CPU1/CP1:

e Connection from CPUO/CPO to Partner => Connection 0OA
e Connection from CPU1/CP1 to Partner => Connection 1A

With double-sided redundancy, there are two connections for CPUO/CPO and
two for CPUL/CP1.:

e Connection from CPUO/CPO to Partner/Node A => Connection 0A
e Connection from CPU1/CP1 to Partner/Node A => Connection 1A
e Connection from CPUO/CPO to Partner/Node B=> Connection 0B

e Connection from CPU1/CP1 to Partner/Node B=> Connection 1B
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The figures in the following example illustrate the denotation of the
connections.

Please note when configuring network connections, that the end points of the
connection (S7: CPO und CP1, partner: node A and node B ) must have at
least one distinctive feature for addressing: either the IP address or the port
number. In HW Config CPO und CP 1 get always different IP-addresses.
Therefore in the network configuration each CP can use the same port
number.

If the communication partner has got only one IP address, then each
connection has to use a different port number.

Usually the Modbus server is addressed via the port number 502; the Modbus
client uses a port number from 2000.

A wrong port number (identical port numbers) will be recognized by NetPro
while entering the value and/or closing the configuration window.

SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems 5-2
2XV9450-1MB11; Manual edition 2.2



Function Block MB_REDCL — Modbus Client

Example: The following figure illustrates a configuration example in NetPro for single
Single Sided sided redundancy.
Redundancy
| ST is client
THI E:1P¢I:I‘EDP iupl.rnn CRM3-1 ip&l‘inp EI.IPI.TIJP PR3-
w0 dooosnls 0 1000
HE | m mm | m
2000 2000

0A 1A

502 503
10.0.0.60

partneris server
[ ]

The S7-station has got the IP-addresses 10.0.0.50 and 10.0.0.51 and can use
the port number 2000 for both connections. The communication partner has
got the IP-Address 10.0.0.60 and must be addressed with 2 different port
numbers: 502 and 503.

Example: The following figure illustrates a configuration example in NetPro for double
Double Sided sided redundancy.
Redundancy
| S7 Is client
& || ZPRU . OP .IIFI.'DP|CP1L3-1 CPRL . OP .l.IPI."DF|I3PU3-1
i) ' it ) H
= M o Voo iu| MR [N =y
o (. mE | m
2000 \Omm zm’lqy 2001
502|503 s02, 503
10.0.0.60 10.0.061
: partner is server
| W [

The S7-station has got the IP-addresses 10.0.0.50 and 10.0.0.51. For the
access to node A of the communication partner, both CPs, CP0 and CP1,
can use port number 2000, because both of them are having different IP-
Addresses (connection OA and 1A).

For the access to node B of the communication partner, it is also possible
that both CPs, CP0O and CP1, use the same Port number 2001(Connection
0B and 1B).

The communication partner has got the IP-Addresses 10.0.0.60 and
10.0.0.61. For the access to CPO of S7, node A and node B can use the
same port number: 502(Connection OA and OB). For the access to CP1 of S7
it is also possible to use the same port number: 503 (Connection 1A and 1B).
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5.2  Functionality of FB MB_REDCL

General

Performed
Functions

Call of the FB

It is possible to run an H-station as Modbus client and Modbus server
simultaneously. Therefore the adequate blocks for client and server
communication must be called and the necessary connections in NetPro
must be parameterized. For each group of redundant connections —
consisting of 2 connections for single sided redundancy or 4 connections for
double sided redundancy — the Modbus block must be called once.

That means, when the H-station acts as client and as server with single sided
redundancy, 2 connections for the server call and 2 connections for the client
call are required in NetPro. When the H-station acts as client and as server
with double sided redundancy, 4 connections for the server call and 4
connections for the client call are required in NetPro.

There is no limitation of the maximum number of parallel called Modbus
blocks on the part of the library. Though it depends on the CPU how many
AG functions can run simultaneously. The maximum number of AG calls can
be taken from the manual of the CPU: "Technical Data" > "Communication".
In the manual of the CP it's detailed, how many connections can be
processed by this CP simultaneously.

The function block MB_REDCL performs the following functions:
e Coordination via which connection(s) the telegrams are sent
e Monitoring of all parameterized connections with AG_CNTRL

e Control the Transaction identifier Tl

The function block MB_REDCL executes a multiple call of MB_CPCLI and
coordinates these calls for the different connections.

The function block MB_CPCLI performs the following functions:

e Calls the standard functions for the data transfer between the CPU
and the CP

o Generates MODBUS specific telegram header before send
¢ Verification of the MODBUS specific telegram header after receive

e Verification if the memory areas exist which are requested by the
client

e Data transfer to and from the parameterized DB

e Monitoring the data reception with a time-out

The function block has to be called both in the start up OB100 as well as in a
cyclic OB.

For each connection of NetPro, the FB MB_REDCL can be called once.
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Online-Help

Start up of the FB

Cyclical Operation
of the FB

OB121
“Programming
Error”

Initiate Request
CP is Client

SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems

In SIMATIC Manager an online help for function block MB_REDCL is
provided. Mark the FB and press the key “F1”. The online help is displayed; it
contains the main information regarding the FB.

The function block MB_REDCL should be unconditionally called once in
OB100. The initialization parameters must be set according to the station
configuration. They will be copied into the instance DB.

The runtime parameters will not be evaluated during the start up.

In cyclical operation the MB_REDCL is called e.g. in OB35. According to the
runtime parameters, the functions of the function block are activated. While a
request is running, changes to the runtime parameters are ignored.

During cyclical operation changes to the initialization parameters are ignored.

If the block has not been licensed yet, the OB121 is called.

Warning

The CPU will turn to STOP mode, if the OB121 is not available.

A rising edge at the trigger input ENQ initiates a request via the active
connection. Depending on the inputs parameters UNIT, DATA_TYPE,
START_ADDRESS, LENGTH and WRITE_READ a MODBUS request is
generated and sent to the partner station via TCP/IP connection. The client
waits for the parameterized monitoring time for a response from the server.

When in the first execution of a cyclic FB after restart of the H-system a job

is triggered via all connections, the standby CPU may report error 80B2 once.
This happens due to system characteristics of the H-system.

5-5

2XV9450-1MB11; Manual edition 2.2



Function Block MB_REDCL — Modbus Client

Sending
Telegrams via a
Single Connection

The Modbus telegram is sent via a single - the current active - connection,
when use_all_conn = FALSE. In case the monitoring time elapses (no answer
from the server) or a faulty connection, the telegram will be sent successively
via the other configured connections (maximum 4). The sequence in doing so
is OA, 1A, OB und 1B. When a telegram was transferred successfully via one
connection, this one is marked “active” and the following telegrams are
transferred via this active connection. In case of a connection error of the
active connection, a transmission retry is carried out via the other
parameterized connections. If all transmission attempts fail, ERROR and
STATUS_x are set accordingly.

When the client receives a respond, a validity check is carried out. If the
result is positive, necessary actions will be taken and the request will be
terminated without error. The output DONE is set. When an error is
recognized during verification, the request is terminated with an error, the
ERROR bit is set and an error number is returned in STATUS_x. In this case
the request telegram will not be sent again via the next configured
connection.

The switch-over to the next configured connection only takes place if a
connection break-down occurs or no answer was received.

P> CoONnection 0A
Connection 1A

1/0 at modbus block

ENQ = TRUE *’

1
(@]
E
z
o Response
= <
DONE = TRUE
ERROR = FALSE
STATUS_0A =0
STATUS_1A=0
Connection
interrupted
ENQ =TRUE 7 Request
(@]
E Internal: 8304
o Request
=
o
(@]
E
zZ Response
(@]
=
DONE=TRUE | ~
ERROR = FALSE v

Connection 0A

STATUS_0A = 8304 \
is recovered

STATUS_1A=0

I: Check of
AG_CNTRL|  ¢onnections
DONE=FALSE ~
ERROR = FALSE
STATUS 0A=0
STATUS 1A=0 Connection 1A is

still used

ENQ = TRUE Request

Response

MONITOR

DONE = TRUE
ERROR = FALSE
STATUS 0A=0
STATUS_1A=0

v Y v
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Sending
Telegrams via all
Connections

The Modbus telegram is sent via all parameterized connection, when
use_all_conn = TRUE. When the client receives a respond, a validity check
is carried out. If the result is positive, necessary actions will be taken.

The outputs DONE, ERROR and STATUS are set not until the reception of
responds via all parameterized connections.

While at least a response is received via one connection, the output DONE is
set.

If errors are detected at all connections, the output ERROR is set and the
error codes are displayed in STATUS_x.

When a parameterized connection fails, the following Modbus telegrams are

not transferred via the faulty connection as long as the connection testing (=>
section 5.3) recognizes the reestablishment of this connection.

Case a) All responds were received without an error.

—» Connection 0A
Connection 1A

Server

1/0 at modbus block

ENQ=TRUE Request
o
O
'_
= Response
o) ‘_ 
=
DONE=TRUE [ T
ERROR = FALSE
STATUS 0A =0 v
STATUS 1A =0
A \
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Case b) At least one respond was not received successfully.

STATUS_0A =0

1/O at modbus block
ENQ = TRUE

DONE = TRUE
ERROR = FALSE

STATUS_1A =8304

— Connection 0A
Connection 1A

[ Client |

MONITOR

Request Connection

4“

Server

ENQ = TRUE Request
@
O  ,
=
zZ
2 | e
DONE=TRUE™ "~~~
ERROR = FALSE .
STATUS 0A=0 Connection 1A
STATUS 1A =0 is recovered
Check of
e NI connections
DONE =FALSE ~~~ ~
ERROR = FALSE
STATUS_0A =0
STATUS_1A =0
Both connections
are used again
ENQ = TRUE Request
@ —>
O
|_
= Response
O
=
DONE=TRUE™ "~~~
ERROR = FALSE
STATUS_0A =0 v
STATUS_1A =0 v Y

SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems

2XV9450-1MB11; Manual edition 2.2



Function Block MB_REDCL — Modbus Client

Case c) Not any respond was received.

———— Connection 0A
Connection 1A

Server

Connection
_ Request .
ENQ =TRUE d interrupted

1/0 at modbus block

Response

MONITOR

——]

DONE = FALSE

ERROR = TRUE
STATUS_0A = 8304
STATUS_1A=8304

ENQ=TRUE — |

DONE=FALSE ~~ |

ERROR = TRUE
STATUS_0A = AOFF

STATUS_1A = AOFF Connection 1A

is recovered

Check of
AG_CNTRL connections

DONE = FALSE
ERROR = FALSE
STATUS_0A = 8304
STATUS_1A=0

Connection 1A
ENQ =TRUE Request Y

Response

MONITOR

DONE = TRUE
ERROR = FALSE
STATUS 0A=0 v
STATUS_1A=0
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Data Transfer
CPU-CP

TCP/IP with
CP443-1

Termination of the
TCP connection
by the Communi-
cation Partner

OB121
“Programming
Error”

The data transfer between CP and CPU are done with the standard function
blocks AG_LSEND and AG_LRECV.

At the activation of a MODBUS request by the user the standard blocks
necessary for the CP are called by the FB in the right order and number.

TCP/IP with CP443-1 uses statistic connections. The TCP connection cannot
be disconnected while in run mode. Given this system characteristic,
telegrams might be lost under unfavorable conditions when the
synchronization had been lost after an error. When lost synchronization is
recognized, the connection is terminated and reestablished by means of
AG_CNTRL.

If the communication partner terminates the TCP connection, the next send

can be started not until an idle time of 150 milliseconds has elapsed. This
delay, due to system characteristics, is executed by the function block.

If the block has not been licensed yet, the OB121 is called.

Warning

The CPU will turn to STOP mode, if the OB121 is not available.

5.3 Connection Testing by means of AG_CNTRL

Connection
Testing

The block MB_REDCL recognizes a faulty connection, if during the
transmission of telegrams the communication functions AG_LSEND/
AG_LRECYV report an error.

To detect and solve actual connection problems immediately, you can
activate a feature to check the configured connections cyclically by the
means of AG_CNTRL. The parameter “check_conn_cycle” defines the
interval of the testing. The result of the connection testing is displayed at the
output STATUS_x.

As long as an error of the connection is detected, the FB Modbus doesn’t
attempt to transfer telegrams via this connection.

When the connection testing recognizes that a faulty connection was
reestablished, all further telegrams are transmitted via this connection, too.

When a response was received via all configured connections, the timer of
“check_conn_cycle” is restarted.
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5.4 Parameters of the Function Block MB_REDCL
Parameter Decl | Type Description Value range Init
id 0_a IN WORD | Connection-ID for CPU/CPO according to 1to 64 yes
the configuration in NetPro W#16#1 to
W#16#40
id 1 a IN |WORD | Connection-ID for CPU/CP1 according to 1lto 64 yes
the configuration in NetPro W#16#1 to
W#16#40
id O b IN WORD | Connection-ID for CPU/CPO according to 1to 64 yes
the configuration in NetPro W#16#1 to
: . . W#16#40
Only required with double-sided
redundancy
id1b IN WORD | Connection-ID for CPU/CP1 according to 1to 64 yes
the configuration in NetPro , WH16#1 to
: . . W#16#40
Only required with double-sided
redundancy
laddr_cpO IN |WORD |Input address of the CPO from HW Config CPU yes
dependent
laddr_cpl IN |WORD |Input address of the CP1 from HW Config CPU yes
dependent
check _conn_c|IN TIME Cycle time for connection testing by the T#ls to yes
ycle means of AG_CNTRL T#+24d20h31
m23s
No connection testing 0
use_all_ IN BOOL Telegrams are sent via one connection FALSE yes
conn Telegrams are sent via all configured TRUE
connections
single_write IN BOOL Write 1 Coil/Register: yes
Function code 5 and. 6 are used TRUE
respectively
Function code 15 and 16 are used FALSE
respectively
Init IN BOOL Manual initialization with positive edge TRUE/FALSE no
data_type_1 |IN BYTE 1st data area: data type yes
Coils 1
Inputs 2
Holding Register 3
Input Register 4
db_1 IN WORD | 1st data area: data block number 1 to 65535 yes
W#16#1 to
W#16#FFFF
start_1 IN |WORD |1st data area: first Modbus address in this 0 to 65535 yes
DB W#16#0000 to
W#16#FFFF
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Parameter Decl | Type Description Value range Init
data_type_ 2 |IN BYTE 2nd data area: data type (Cails, Inputs, Oto4 yes
Holding Register, Input Register),

NULL if not used
db_2 IN WORD | 2nd data area: data block number 1 to 65535 yes
W#16#1 to
W#16#FFFF
start_2 IN WORD | 2nd data area: first Modbus address in this | 0 to 65535 yes
DB W#16#0000 to
W#16#FFFF
data_type_3 |IN BYTE 3rd data area: data type (Coils, Inputs, Oto4 yes
Holding Register, Input Register),
NULL if not used
db_3 IN |WORD |3rd data area: data block number 1 to 65535 yes
W#16#1 to
W#16#FFFF
start_3 IN |WORD |3rd data area: first Modbus address in this 0 to 65535 yes
DB W#16#0000 to
W#16#FFFF
data_type_4 |IN BYTE 4th data area: data type (Coils, Inputs, Oto4 yes
Holding Register, Input Register),
NULL if not used
db_4 IN |WORD |4th data area: data block number 1 to 65535 yes
W#16#1 to
W#16#FFFF
start_4 IN WORD | 4th data area: first Modbus address in this 0 to 65535 yes
DB W#16#0000 to
W#16#FFFF
MONITOR IN TIME Monitoring Time: Wait for data from T#20ms to no
communication partner T#+24d20h31
m23s647ms
REG_KEY IN STRING [ Registration key to activate the license Character no
[17]
ENQ IN BOOL Initiate request at positive edge TRUE/FALSE no
DATA_TYPE |IN BYTE Data type to be accessed:
Coils 1
Inputs 2 no
Holding registers 3
Input registers 4
START _ IN WORD | MODBUS start address 0 to 65535 no
ADDRESS W#16#0000 to
W#16#FFFF
LENGTH IN |woRrD |Number of values to be processed no
Coils: reading function 1 to 2000
writing function 1 to 1968
Inputs: reading function 1 to 2000
Holding Reqister: reading function 1to0 125
writing function 1to 123
Input Register: reading function 1to0 125
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Parameter Decl | Type Description Value range Init
WRITE_ IN BOOL Write access TRUE no
READ Read access FALSE
UNIT IN BYTE Unit Identifier 0to 255 no
B#16#0 to
B#16#FF
LICENSED OUT | BOOL License state of the function block: no
Block is licensed TRUE
Block is not licensed FALSE
BUSY OUT | BOOL Operating state of the functions no
AG_LSEND and AG_LRECV
Job processing TRUE
No job processing active FALSE
DONE OUT | BOOL TRUE: Active request finished without TRUE no
errors via one connection at least. FALSE
ERROR OUT | BOOL TRUE: Errors have occurred at all TRUE no
configured connections. FALSE
STATUS OA |OUT |WORD | Status for connection 0OA 0 to FFFF no
STATUS 1A |OUT |WORD | Status for connection 1A 0 to FFFF no
STATUS 0B |OUT |WORD Status for connection 0B 0 to FFFF no
STATUS 1B |OUT |WORD [ Status for connection 1B 0 to FFFF no
IDENT_ OUT | STRING | Identification for licensing Character no
CODE [18] Please order your license with this
identification string.
RedErS7 OUT | BOOL TRUE: S7 lost redundancy TRUE no
FALSE
RedErrDev OUT | BOOL TRUE: 3rd party device lost redundancy TRUE no
FALSE
TotComErr OUT | BOOL TRUE: Complete communication failure TRUE no
FALSE
Init_Error OUT | BOOL TRUE: Error occurred during manual TRUE no
initialization FALSE
Init_Status OUT |WORD | Status of manual initialization 0 to FFFF no
General The parameters of the FB MB_REDCL can be divided into two groups:
information

¢ Initialization parameter
¢ Runtime parameter

The initialization parameters are evaluated only at the first initial execution
of the function block MB_REDCL and taken over into the instance DB. They
are marked in the above table in the column ,INIT* with ,yes".

A modification of the initialization parameters during the runtime has no
impact. After the modification of these parameters (e.g. at the test mode), the
instance DB must be initialized via a STOP/RUN transition of the CPU.
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Range of Values

laddr_cpO,
laddr_cpl

check_conn_cycle

use_all_conn

Runtime parameters can be used in cyclical operations. It is not advised to
change the input parameters while a request is active. Wait with the
preparation of the next request and the change of the parameter until the
previous request ends with DONE or ERROR.

The output parameters are displayed dynamically, i.e. they are only
available for one PLC cycle. They have to be copied to an additional
memory area if you need to process them or to display the values in a VAT
(STEP7 variable table).

For the range of values of the different parameters, CPU specific restrictions
must be taken in consideration.

For each configured connection in STEP7/NetPro, a connection ID is
assigned. The connection ID is the distinct description of the connection from
the CPU via the CP to the communication partner.

The number of the configured connection has to be entered here. The value
range for this parameter depends on the CPU.

id 0 a represents the connection from the CPO to node A
id1a represents the connection from the CP1 to node A
idOb represents the connection from the CPO to node B
id1b represents the connection from the CP1 to node B

The connection OA is the default connection, its configuration is mandatory.

If the communication partner is built up standalone, then the parameters
id 0 aandid_1 a are used.

The parameters laddr_cpO and laddr_cp1l represent the input address of the
CPO and the CP1 from HW Config (I-Address). The configured value has to
be entered here.

The range of values for these parameters depends on the CPU.

This parameter defines the time interval for connection testing by means of
AG_CNTRL. The time can be parameterized in 1 second steps; the default
value is 30 seconds. The results of the connection testing are displayed at the
outputs STATUS_x.

When use_all_conn = FALSE, the connection testing can be skipped by
setting the time interval to 0 seconds.

If check_conn_cycle is parameterized with 0 ms, it's not possible to recognize
a connection error without a telegram traffic via this connection. It is
recommended to set this parameter > 0 ms.

This parameter defines the number of connections Modbus telegrams are
transferred. With the setting FALSE the Modbus telegrams are sent via 1
connection. This parameter set to TRUE causes the Modbus telegrams to be
transferred via all configured connections.
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single_write

Init

data_type_x

db_x

start_x

With single_write = TRUE write requests with length 1 are carried out with the
function codes 5 and 6.

With single_write = FALSE all write requests use the function codes 15 and
16.

The parameter INIT = TRUE enables a manual initialization. The initialization
can be executed, if currently no order is running. This must be ensured in the
user program with ENQ = FALSE and BUSY = FALSE.

If manual initialization, it is important, that the initialization parameters are
parameterized in the cyclical OB.

During a manual initialization the parameterized connections are
terminated and reestablished again.

The parameter data_type_x defines the MODBUS data type which is to be
mapped with this definition.
If data_type_x set to 0, this data area is not used.

Irdent|f|e Data type Size

Area not used
Coils Bit

Holding Register | Word

0
1
2 Inputs Bit
3
4

Input Register Word

The parameter db_x defines the number of the data block in which the
consecutively defined MODBUS registers or bits are mapped.
0 cannot be used as DB number since it is reserved for system functions.

The size of the data blocks must be 2 byte larger than it is necessary for the
Modbus values. The last word is used for internal purposes and it is not
allowed to change it.

Start_x specifies the first register or bit address, which is stored in the data
element O of the DB.

The maximum number of Modbus addresses which can be stored in the DB is
defined by its length. The DB length is calculated during start-up of the CPU.

When accessing registers, the last register address which is mapped in the
S7 DB can be calculated with the following formula:

Last register address in DB = (DB-length (in byte) —2) / 2 + start_x - 1
When accessing coils or inputs, the last register address which is mapped in
the S7 DB can be calculated with the following formula:

Last coil address in DB = (DB-length (in byte) — 2) * 8 + start_x - 1

Please note:
The defined data areas must not overlap.

In section 5.5 you can find an example of the mapping of the MODBUS
addresses to S7 memory areas.
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MONITOR The monitoring time observes the entry of the data input from the
communication partner over the active connection. The minimum time that
can be set is 20ms. A monitoring time of 1,5 seconds is recommended.

MONITOR specifies the timeout for the receipt of the complete response
telegram from the server. When the monitoring time elapses, the active
request is cancelled with an error. The time is started after sending of the
request telegram is finished and is stopped after the receipt of the complete
data.

REG_KEY The Modbus block must be licensed for each CPU individually to permit a
correct program sequence. With the registration key REG_KEY the Modbus
block is licensed and the Modbus communication runs without any restraint.

You can find further information in section “Licensing”.

ENQ The data transfer is initiated with a TRUE signal at the input. The request
telegram is generated with the values of input parameters UNIT,
WRITE_READ, DATA_TYPE, START_ADDRESS and LENGTH. A new
request can only be sent when the previous one is finished with DONE or

ERROR.

DATA_TYPE The parameter DATA_TYPE defines which Modbus data type is to be
accessed with the current job. The following data types are available:
Coils B#16#1
Inputs B#16#2
Holding Register B#16#3
Input Register B#16#4

The different data types are related directly to the used function codes.

Data type DATA_ | Function | Length | single_ Function
TYPE write code
Coils 1 read any irrelevant 1
Coils 1 write 1 TRUE 5
Coils 1 write 1 FALSE 15
Coils 1 write >1 irrelevant 15
Inputs 2 read any irrelevant 2
Holding Register 3 read any irrelevant 3
Holding Register 3 write 1 TRUE 6
Holding Register 3 write 1 FALSE 16
Holding Register 3 write >1 irrelevant 16
Input Register 4 read any irrelevant 4

START_ADDRESS The parameter START_ADDRESS specifies the first MODBUS address that
is read or written.
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LENGTH

WRITE_READ

UNIT

LICENSED

BUSY

DONE

ERROR

STATUS_OA,
STATUS_1A,
STATUS_O0B,
STATUS_1B

IDENT_CODE

The parameter LENGTH specifies the number of MODBUS values that are
read or written.

For read functions, a maximum of 125 Holding Registers and Input Registers
is possible per telegram. For Coils and Inputs a maximum of 2000 bits is
possible. For write functions a maximum of 123 Holding Registers or 1968
Coils is possible.

All registers or bits have to be in the same DB per telegram.

This parameter defines if a read or write function should be carried out. If the
value of the input/output is FALSE, it specifies the read mode. The value
TRUE specifies the write mode.

This input has to be set according to the requirements. The FB copies this
value to the request telegram and verifies when the respond telegram is
received.

Please note, that some communication partners expect a certain unit
number.

If this output is TRUE, then the Modbus block is licensed on this CPU. If the
output is FALSE, none or a faulty license string was typed in. You can find
further information in section 4 “Licensing”.

If this output is TRUE, one of the functions AG_LSEND or AG_LRECV is
running.

The activated request was executed without error via one connection at least.
For a read function the response data from the server has already been
entered into the DB. For a write function the response to the request telegram
has been received from the server.

When this output is set, errors occurred at all active connections.

use_all_conn = FALSE:

In case of a protocol error, ERROR is immediately set. In case of a
connection error, all the configured connections are verified and ERROR is
set not until all connections report an error.

use_all conn = TRUE:
When this output is set, errors occurred at all configured connections.

The error number is displayed in the STATUS_x outputs.
The STATUS_x outputs display the error number when ERROR is TRUE. As
long as ERROR is FALSE, STATUS_ x displays status information for the

corresponding connection.

The error numbers and the status information are described in chapter
“Diagnostics”.

After start-up of the PLC this parameter displays the identification code, an
18 character string. With this IDENT_CODE you can order the registration
key.

You can find further information in section “Licensing”.
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RedErrS7 If this output is true, the SIMATIC lost redundancy.
In single-sided redundancy mode the connection of CPO or CP1 is disturbed.
In double-sided redundancy mode both connections of CPO or both
connections of CP1 are disturbed.
You can find further information in section 9.5 “Diagnostics with Alarm
Bits”.

RedErrDev If this output is true, the 3rd party device lost redundancy.
In single-sided redundancy mode the connection from node A to CPO or to
CP1 is disturbed. In double-sided redundancy mode both connections to node
A or both connections to node B are disturbed.
You can find further information in section 9.5 “Diagnostics with Alarm
Bits”.

TotComErr The output TotComErr = TRUE shows a complete communication failure. All
connections are disturbed.
You can find further information in section 9.5 “Diagnostics with Alarm
Bits”.

Init_Error An error during the manual initialization is shown with Init_Error = TRUE.

Init_Status The output Init_Status displays the error number when Init_Error is TRUE.
The error numbers are described in section 9 “Diagnostics”.
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5.5 Example for Address Mapping

Interpretation of
Modbus
Addresses

Example:
Parameterization
of the Memory
Areas

Address Mapping

MODBUS bases its data model on a series of tables, which have
distinguishing characteristics. The distinction between these memory areas is
done via the register address by some systems, e.g. MODICON PLCs. So a
MODBUS message requesting the read of a holding register at offset 0 would
return the value known to the application programmer as found in register
40001 (memory type 4xxxx, reference 0001).

One potential source of confusion is the varying interpretation of the register
address in different manuals. Sometimes the register address means the
address of the application layer, sometimes the address transferred.

The FB MB_REDCL uses the Modbus address transferred at its
parameters start_x und START_ADDRESS. So it is possible to use register
addresses from von 00004 to FFFF with each function code.

data_type 1 B#16#3 Holding Register
db_1 W#16#B DB 11

start 1 W#16#1 start address: 0
data_type_ 2 B#16#3 Holding Register
db_2 W#16#C DB 12

start 2 W#16#2D0 start address: 720
data_type_3 B#16#0 not used

db_3 0 0

start 3 0 0

data_type_4 B#16#1 Coils

db_4 W#16#D DB 13

start 4 W#16#2D0 start address: 640

For this example applies:

o DBI11 consists of 1002 byte; 500 registers are mapped (register 0 —
register 499) + 2 reserved byte

o DBI12 consists of 364 byte, 181 register are mapped (register 720 —
register 900) + 2 reserved byte

¢ DB13 consists of 79 byte, 611 bits are mapped (Coil 640 — Coil 1250)
+ 2 reserved byte

The following diagram shows the comparison of the SIMATIC memory area
and the Modbus typical register oriented storage arrangement. The diagram
is based on the above parameterization.

Box Modbus device: The Modbus addresses printed in black refer to the Data
Link Layer, the ones printed in grey refer to the Application Layer.

Box SIMATIC: The SIMATIC addresses printed in black are the offset in the
DB. You can find additionally the Modbus register numbers printed in grey.
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SIMATIC
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5.6 Data and Standard Function used by the FB

Instance DB

Local Variables

Timers
Flags

Standard-FCs for
Data Transfer

The function block MB_REDCL stores its data in an instance DB. This
instance DB is created by STEP7 at the first call of the FB.

The instance data block contains parameters of type Input, Output,
Input/Output as well as static variables needed for its execution. These
variables are non-volatile and keep its validity between FB calls. The
variables control the internal process flow of the FB.

Required memory of the instance-DBs:

Instance-DB | work memory load memory
MB_REDCL | ca. 4 kByte ca. 5 kByte

The FB requires 96 Bytes of local variables. Additionally the subordinate FBs
require local variables: FBs MB_CPCLI (28 byte) or AG_CNTRL (178 byte).
That gives a maximum of 302 Bytes of local data for a FB MB_REDCL-call.

The function block does not use any timer.
The function block does not use any flags.

The function block uses the blocks AG_LSEND and AG_LRECYV from the
SIMATIC_NET library for the data transfer between CPU and CP.

AG_CNTRL is used additionally to reset and restart a connection in case of
error.

The following versions of the FCs are tested with the FB MB_REDCL and
released for the communication:

e FC50,AG_LSEND* Version 3.1
e FC60,AG_LRECV" Version 3.1
e ,AG_CNTRL" (CP 400) Version 1.0
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SFCs and FCs for

Miscellaneous

The FB MB_REDCL uses the following SFCs from the standard library:
e SFB4 ,TON®

Functions
e SFC6 ,RD_SINFO*
e SFC20 ,BLKMOV*
e SFC51 ,RDSYST”
e SFC52 ,WR_USMSG”
The block MB_CPCLI uses the following system functions:
e SFC20 ,BLKMOV*
e SFC24 ,TEST_DB”
e SFB4 ,TON®
Additional The parameter Tl is operated internally in MB_REDCL and is incremented
Information with each new request.
Error 8304: When the connection from the CP to the communication partner
is interrupted, the interruption is recognized by the CP and error number 8304
stored.
When a communication request is activated, first error code 8304 is returned
even if the connection is available again, because this error code is still
stored. This is a given system characteristics of the CP.
When the MODBUS function block returns ERROR=TRUE and
STATUS=8304, the communication request should be activated once again.
The time delay to recognize the termination of a connection can be modified
with the parameter “Send Keepalives for Connections” of the CP’s properties
in HW Config.
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5.7 Renaming / Rewiring of Standard Functions and Function Blocks

Inducement Whether you have already used the numbers of standard functions in your
project or the block number is reserved for a different application (e.g. in
CFC), you may rename/rewire the internal called function blocks
AG_LSEND/AG_LRECYV or the blocks MB_REDCL and MB_CPCLI.

It is not possible to rename/rewire the system functions SFC6, SFC20,
SFC24, SFC51 and SFC52 as well as the system function block SFB4.

Sequence You must follow some rules regarding the block numbers when rewiring
blocks in the SIMATIC Manager of STEP7.

If you want to rewire the blocks of the Modbus library, the following sequence
is required:

1. FC50 AG_LSEND
FC60 AG_LRECV

2. FB908 MB_CPCLI
FB906 MB_CPSRV

3. FB909 MB_REDCL
FB907 MB_REDSV

It is not necessary to rewire all blocks. Even if you want to rewire only some
of the blocks, you must follow the mentioned sequence.

Renaming To rewire proceed as described subsequently:

1. Get the information about the used operand by clicking "Extras >
Reference data > Display".

2. Set the operand priority in the object properties of the block folder to
"Absolute value".

3. Call the function "Extras > Re-wire" in the SIMATIC Manager, in
order to re-wire the operands into free areas.

4. To be able to keep on using the symbolism diagnostics tools, add the
modifications in the symbolism table supplementary.

The modifications can be verified by clicking "Extras > Reference data
> Display".
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6 Function Block MB_REDSV — Modbus Server

6.1 Configuration of the Redundant Communication

General
Information

Configuration in

HW Config

Configuration in

NetPro

The CP is server if the remote partner takes the initiative to read data from or
to write data to the S7.

The communication partner of the H-system can be mounted stand-alone or
redundant, too (single sided or double sided redundancy).

Single sided redundancy Double sided redundancy

IH Single-sided (Server) H Double-sided (Server)
% I cPU L DF  CMPLDP|CR CPU  OF JMPLDP (CP & I cCPU :DF :I.IFI."DF cCP (=211 :DF :l.IFI."DF (=3}
in | i) H [Ex] EAFETaN H W1 ] :‘“—‘ H i -1 :iﬂ—i ' W
Ho i Ho i H H i i
H | =] H = | =] Ho | ] Hoe ]
] 1 ] 1
Switch Switch
A A B

| |Cther station(Client2)

| |Cther station (Client1)

While configuring the hardware in HW Config, both CP0O and CP1 get
different input and IP addresses, so that they can be addressed unique in the
S7-program respectively from the communication partner.

You have to define one connection in NetPro for each possible connection
between the communication partners.

With single sided redundancy, there is one connection for CPUO/CPO and
one for CPU1/CP1:

e Connection from CPUO/CPO to Partner => Connection 0OA
e Connection from CPU1/CP1 to Partner => Connection 1A

With double-sided redundancy, there are two connections for CPUO/CPO and
two for CPUL/CP1.:

e Connection from CPUO/CPO to Partner/Node A=> Connection 0OA
e Connection from CPU1/CP1 to Partner/Node A=> Connection 1A
e Connection from CPUO/CPO to Partner/Node B=> Connection 0B

e Connection from CPU1/CP1 to Partner/Node B=> Connection 1B
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The figures in the following example illustrate the denotation of the
connections.

Please note when configuring network connections, that the end points of the
connection (S7: CP0O und CP1, partner: node A and node B) must have at
least one distinctive feature for addressing: either the IP address or the port
number. In HW Config CPO und CP 1 get always different IP-addresses.
Therefore in the network configuration each CP can use the same port
number.

If the communication partner has got only one IP address, then each
connection has to use a different port number.

Usually the Modbus server is addressed via the port number 502; the Modbus
client uses a port number different from 502.

A wrong port number (identical port numbers) will be recognized by NetPro
while entering the value and/or closing the configuration window.
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Example: The following figure illustrates a configuration example in NetPro for single
Single Sided sided redundancy.
Redundancy
| S7 is server
..r H E1F¢EI¢EDF iuplmp [FIJTRE] lfrﬂinp iupmp [STJTEE]
w oo 1000s0f. ¢ ¢ 10.0.0.51
mom | m m o | m
502 502

0A 1A

2000 2001

10.0.0.60
| partner is client

=

The S7-station has got the IP-addresses 10.0.0.50 und 10.0.0.51 and can be
addressed via both connections with the port number 502.The
communication partner has got the IP-Address 10.0.0.60 and has to use 2
different port numbers for the two connections: 2000 und 2001

Example: The following figure illustrates a configuration example in NetPro for double
Double Sided sided redundancy.
Redundancy
| S7 is server
£ ” Erﬂinp iupm:up CRU3- Eﬂ:l‘inp iupmp|cpua-1
i noosolitt ) 1000t
‘W E | m 'mE m
502/ 503 502|503
2000( 2001 2000, (2001
10.0.0.60 10.0.0.61
gi partner is client
| [ m

The S7-station has got the IP addresses 10.0.0.50 and 10.0.0.51.for the
access from node A of the communication partner. Both CPs, CP0 and CP1,
can use port number 502, because both of them are having different
IP-addresses (connection OA and 1A).

For the access from node B of the communication partner, it is also possible
that both CPs, CP0O and CP1 use the same port number 503 (Connection 0B
and 1B).

The communication partner has got the IP-Addresses 10.0.0.60 and
10.0.0.61 for the access to CPO of S7, node A and node B can use the same
port number: 2000 (connection OA and OB). For the access to CP1 of S7 itis
also possible to use the same port number: 2001 (connection 1A and 1B).
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6.2 Functionality of the FB MB_REDSV

General

Performed
Functions

Call of the FB

It is possible to run an H-station as Modbus client and Modbus server
simultaneously. Therefore the adequate blocks for client and server
communication must be called and the necessary connections in NetPro
must be parameterized. For each group of redundant connections —
consisting of 2 connections for single sided redundancy or 4 connections for
double sided redundancy — the Modbus block must be called once.

That means, when the H-station acts as client and as server with single sided
redundancy, 2 connections for the server call and 2 connections for the client
call are required in NetPro. When the H-station acts as client and as server
with double sided redundancy, 4 connections for the server call and 4
connections for the client call are required in NetPro.

There is no limitation of the maximum number of parallel called Modbus
blocks on the part of the library. Though it depends on the CPU how many
AG functions can run simultaneously. The maximum number of AG calls can
be taken from the manual of the CPU: "Technical Data" > "Communication".
In the manual of the CP it's detailed, how many connections can be
processed by this CP simultaneously.

The function block MB_REDSV executes a multiple call of MB_CPSRYV and
coordinates these calls for the different connections.

The function block MB_CPSRYV performs the following functions:

e Calls the standard functions for the data transfer between the CPU
and the CP

o Generates MODBUS specific telegram header before send
¢ Verification of the MODBUS specific telegram header after receive

e Verification if the memory areas exist which are requested by the
client

e Generate exception telegrams when failures occur

Exception | Meaning
code

1 The requested function code is not supported.

An access to a not existing or not permitted address
was carried out.

2

An invalid length was indicated for this function

3 code.

e Data transfer to and from the parameterized DB

e Monitoring the data reception with a time-out

The function block has to be called both in the start up OB100 as well as in a
cyclic OB.
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Online-Help

Start up of the FB

Cyclical Operation
of the FB

Activation of the
Function Block

In SIMATIC Manager an online help for function block MB_REDSV is
provided. Mark the FB and press the key “F1”. The online help is displayed; it
contains the main information regarding the FB.

The function block MB_REDSV should be unconditionally called once in
OB100. The initialization parameters must be set according to the station
configuration. They will be copied into the instance DB.

The runtime parameters will not be evaluated during the start up.

In cyclical operation the MB_REDSV is called e.g. in OB35. According to the
runtime parameters, the functions of the function block are activated.

During cyclical operation changes to the initialization parameters are ignored.

The connection of the standby CPU may report error 80B2 once after restart
of the H-system. This happens due to system characteristics of the H-system.

With a true signal at the input ENR the FB is ready to receive a request
telegram from the client. The server remains passive.

With ENR = TRUE all configured connections are active and the CP listens to
them. No switch over from one connection to the redundant one takes place.
The client can send the request via one or via all connections alternatively.

The received telegrams are verified. If a telegram is verified positive, the
response telegram is generated and sent. The completed transmission is
reported to the user by setting the output NDR_x.

A faulty request telegram causes an error message and the output ERROR_x
of the associated connection is set. The error number is returned in
STATUS_x. Depending on the kind of error, the request of the client is either
answered with an exception telegram or no response is sent.

SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems 6-5
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Instance-DB:
Information
Regarding the
Request of the
Client

SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems

The basic data of the executed Modbus order is stored in an information

block in the IDB of the server with each request of the client. This information

can be readout in the application program if required. The following values
are buffered in the IDB for each connection and are valid when NDR =

TRUE:

Address in |-DB
for Connection
0A

Variable

Description

DBX 120.0 CONNECTION[1]. | TRUE: Write to S7
WRITE_READ FALSE: Read from S7
DBB 121 CONNECTION[1]. | Unit number
UNIT
DBB 122 CONNECTION[1]. | Accessed data type
DATA_TYPE 1: Coils
2: Inputs
3: Holding register
4: Input register
DBW 124 CONNECTION[1]. | First address accessed
START_ADDRES
S
DBW 126 CONNECTION[1]. | Number of executed registers
LENGTH / bits
DBW 128 CONNECTION[1]. | Transaction Identifier
TI (Sequence number)
DBD 130 CONNECTION[1]. | Counter of correct executed
Cnt_NDR requests
DBD 134 CONNECTION[1]. | Counter of recognized errors

Cnt_ERROR

Two counters for NDR and ERROR are available for each connection as well.

The information block for connection 1A (CONNECTION|2]) starts at

DBX 154.0 of the IDB.

The information block for connection 0B (CONNECTION|[3]) starts at

DBX 188.0 of the IDB.

The information block for connection 1B (CONNECTION[4]) starts at

DBX 222.0 of the IDB.

2XV9450-1MB11; Manual edition 2.2
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Data Transfer
CPU-CP

TCP/IP with
CP443-1

Termination of the
TCP connection
by the Communi-
cation Partner

OB121
“Programming
Error”

The data transfer between CP and CPU are done with the standard function
blocks AG_LSEND and AG_LRECV.

At the receipt of a telegram from the client the standard blocks necessary for
the CP are called by the FB in the right order and number.

TCP/IP with CP443-1 uses statistic connections. The TCP connection cannot
be disconnected while in run mode. Given this system characteristic,
telegrams might be lost under unfavorable conditions when the
synchronization had been lost after an error. When the FB detects lost
synchronization, the connection is terminated and reestablished by means of
AG_CNTRL.

If the communication partner terminates the TCP connection, the next

receive can be started not until an idle time of 1 second has elapsed. This
delay, due to system characteristics, is executed by the function block.

If the block has not been licensed yet, the OB121 is called.

Warning

The CPU will turn to STOP mode, if the OB121 is not available.

6.3 Connection Testing by means of AG_CNTRL

Connection
Testing

The block MB_REDSV recognizes a faulty connection, if during the
transmission of telegrams the communication functions AG_LSEND/
AG_LRECYV report an error.

To detect and solve actual connection problems immediately, the configured
connections are checked cyclically by the means of AG_CNTRL.

The parameter “check_conn_cycle” defines the interval of the testing. The
result of the connection testing is displayed at the output STATUS_x.
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6.4 Parameters of the Function Block MB_REDSV
Parameter Decl | Type Description Value range Init
id 0_a IN WORD | Connection-ID for CPU/CPO according to 1to 64 yes
the configuration in NetPro W#16#1 to
W#16#40
id 1 a IN |WORD | Connection-ID for CPU/CP1 according to 1lto 64 yes
the configuration in NetPro W#16#1 to
W#16#40
id O b IN WORD | Connection-ID for CPU/CPO according to 1to 64 yes
the configuration in NetPro W#16#1 to
: . . W#16#40
Only required with double-sided
redundancy
id1b IN WORD | Connection-ID for CPU/CP1 according to 1to 64 yes
the configuration in NetPro , WH16#1 to
: . . W#16#40
Only required with double-sided
redundancy
laddr_cpO IN |WORD |Input address of the CPO from HW Config CPU yes
dependent
laddr_cpl IN |WORD |Input address of the CP1 from HW Config CPU yes
dependent
check_conn_c | IN TIME Cycle time for connection testing by the T#ls to yes
ycle means of AG_CNTRL T#+24d20h31
m23s
data_type_1 |IN BYTE 1st data area: data type yes
Coils 1
Inputs 2
Holding Register 3
Input Register 4
db_1 IN WORD | 1st data area: data block number 1 to 65535 yes
W#16#1 to
W#16#FFFF
start_1 IN WORD | 1st data area: first Modbus address in this 0 to 65535 yes
DB W#16#0000 to
W#16#FFFF
data_type_2 |IN BYTE 2nd data area: data type (Cails, Inputs, Oto4 yes
Holding Register, Input Register),
NULL if not used
db_2 IN |WORD |2nd data area: data block number 1 to 65535 yes
W#16#1 to
W#16#FFFF
start_2 IN WORD | 2nd data area: first Modbus address in this | 0 to 65535 yes
DB W#16#0000 to
W#16#FFFF
data_type_3 |IN BYTE 3rd data area: data type (Coils, Inputs, Oto4 yes
Holding Register, Input Register),
NULL if not used
SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems 6-8
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Parameter Decl | Type Description Value range Init
db_3 IN |WORD |3rd data area: data block number 1 to 65535 yes
W#16#1 to
W#16#FFFF
start_3 IN WORD | 3rd data area: first Modbus address in this 0 to 65535 yes
DB W#16#0000 to
W#16#FFFF
data_type_4 |IN BYTE 4th data area: data type (Coils, Inputs, Oto 4 yes
Holding Register, Input Register),
NULL if not used
db_4 IN WORD | 4th data area: data block number 1 to 65535 yes
W#16#1 to
W#16#FFFF
start_4 IN WORD | 4th data area: first Modbus address in this 0 to 65535 yes
DB W#16#0000 to
W#16#FFFF
MONITOR IN TIME Monitoring Time: Wait for data from T#20ms to no
communication partner T#+24d20h31
m23s647ms
REG_KEY IN STRING [ Registration key to activate the license Character no
[17]
ENR IN BOOL Ready for receive at true signal TRUE/FALSE no
Init IN BOOL Manual initialization with positive edge TRUE/FALSE no
LICENSED OUT | BOOL License state of the function block: no
Block is licensed TRUE
Block is not licensed FALSE
BUSY OUT | BOOL Operating state of the functions no
AG_LSEND and AG_LRECV
Job processing TRUE
No job processing active FALSE
NDR_OA OUT | BOOL TRUE: The request of the client via TRUE no
connection OA was executed and FALSE
responded to.
ERROR _OA [OUT |BOOL TRUE: An error has occurred — connection TRUE no
0A FALSE
STATUS OA |OUT |WORD | Status for connection 0A 0 to FFFF no
NDR_1A OUT | BOOL TRUE: The request of the client via TRUE no
connection 1A was executed and FALSE
responded to.
ERROR_1A [OUT |BOOL TRUE: An error has occurred — connection TRUE no
1A FALSE
STATUS 1A |OUT |WORD | Status for connection 1A 0 to FFFF no
NDR_0OB OUT | BOOL TRUE: The request of the client via TRUE no
connection OB was executed and FALSE
responded to.
ERROR 0B |OUT [BOOL TRUE: An error has occurred — connection TRUE no
0B FALSE
SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems 6-9
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Parameter Decl | Type Description Value range Init
STATUS 0B |(OUT |WORD Status for connection 0B 0 to FFFF no
NDR_1B OUT | BOOL TRUE: The request of the client via TRUE no
connection 1B was executed and FALSE
responded to.
ERROR 1B |OUT [BOOL TRUE: An error has occurred — connection TRUE no
1B FALSE
STATUS 1B |OUT |WORD Status for connection 1B 0 to FFFF no
IDENT _ OUT | STRING | Identification for licensing. Please order Character no
CODE [18] your license with this identification string.
RedErrS7 OUT | BOOL TRUE: S7 lost redundancy TRUE/FALSE no
RedErrDev OUT | BOOL TRUE: 3rd party device lost redundancy TRUE/FALSE no
TotComErr OUT | BOOL TRUE: Complete communication failure TRUE/FALSE no
Init_Error OUT | BOOL TRUE: Error occurred during manual TRUE/FALSE no
initialization.
Init_Status OUT |WORD | Status of manual initialization 0 to FFFF no
General The parameters of the FB MB_REDSV can be divided into two groups:
information

Range of Values

SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems

¢ Initialization parameter
¢ Runtime parameter

The initialization parameters are evaluated only at the first initial execution
of the function block MB_REDSYV and taken over into the instance DB. They
are marked in the above table in the column ,INIT* with ,yes".

A modification of the initialization parameters during the runtime has no
impact. After the modification of these parameters (e.g. at the test mode), the
instance DB must be initialized via a STOP/RUN transition of the CPU.

Runtime parameters can be used in cyclical operations. It is not advised to
change the input parameters while a request is active.

The output parameters are displayed dynamically, i.e. they are only
available for one PLC cycle. They have to be copied to an additional
memory area if you need to process them or to display the values in a VAT
(STEP7 variable table).

For the range of values of the different parameters, CPU specific restrictions
must be taken in consideration.

6-10

2XV9450-1MB11; Manual edition 2.2



Function Block MB_REDSV — Modbus Server

laddr_cpO,
laddr_cpl

check_conn_cycle

For each configured connection in STEP7/NetPro, a connection ID is
assigned. The connection ID is the distinct description of the connection from
the CPU via the CP to the communication partner.

The number of the configured connection has to be entered here. The value
range for this parameter depends on the CPU.

id 0 a represents the connection from the CPO to node A.
id1a represents the connection from the CP1 to node A
idOb represents the connection from the CPO to node B
id1b represents the connection from the CP1 to node B

The connection OA is the default connection, its configuration is mandatory.

If the communication partner is built up standalone, then the parameters
id 0 aandid_1 a are used.

The parameters laddr_cpO and laddr_cp1l represent the input address of the
CPO and the CP1 from HW Config (I-Address). The configured value has to
be entered here.

The range of values for these parameters depends on the CPU.

This parameter defines the time interval for connection testing by the means
of AG_CNTRL. The time can be parameterized in 1 second steps; the default
value is 30 seconds. The results of the connection testing are displayed at the
outputs STATUS_x.

data_type_x The parameter data_type_x defines the MODBUS data type which is to be
mapped with this definition.
If data_type_x set to 0, this data area is not used.
Irdent|f|e Data type Size
0 Area not used
1 Coils Bit
2 Inputs Bit
3 Holding Register | Word
4 Input Register Word
db_x The parameter db_x defines the number of the data block in which the
consecutively defined MODBUS registers or bits are mapped.
0 cannot be used as DB number since it is reserved for system functions.
The size of the data blocks must be 2 byte larger than it is necessary for the
Modbus values. The last word is used for internal purposes and it is not
allowed to change it.
SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems 6-11
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start_x

MONITOR

REG_KEY

ENR

Init

LICENSED

Start_x specifies the first register or bit address, which is stored in the data
element O of the DB.

The maximum number of Modbus addresses which can be stored in the DB is
defined by its length. The DB length is calculated during start-up of the CPU.

When accessing registers, the last register address which is mapped in the
S7 DB can be calculated with the following formula:

Last register address in DB = (DB-length (in byte) —2) / 2 + start_x - 1
When accessing coils or inputs, the last register address which is mapped in
the S7 DB can be calculated with the following formula:

Last coil address in DB = (DB-length (in byte) — 2) * 8 + start_x - 1

Please note:
The defined data areas must not overlap.

In section 6.5 you can find an example of the mapping of the MODBUS
addresses to S7 memory areas.

The monitoring time observes the entry of the data input from the
communication partner over the active connection. The minimum time that
can be set is 20ms. A monitoring time of 1,5 seconds is recommended.

MONITOR specifies the timeout for the receipt of the complete response
telegram from the server. When the monitoring time elapses, the active
request is cancelled with an error. The time is started after sending of the
request telegram is finished and is stopped after the receipt of the complete
data.

The Modbus block must be licensed for each CPU individually to permit a
correct program sequence. With the registration key REG_KEY the Modbus
block is licensed and the Modbus communication runs without any restraint.

You can find further information in section “Licensing”.

The FB is activated with a TRUE signal at this input. Telegrams from the
client can be received. With a FALSE signal at this input data is received
from the CP and discarded.

The FB listens to all configured connections. Requests via all connections are
executed and replied to.

The parameter INIT = TRUE enables a manual initialization. The initialization
can be executed, if currently no order is running. The client must not send a
request during initialisation.

If manual initialization, it is important, that the initialization parameters are
parameterized in the cyclical OB.

During a manual initialization the parameterized connections are
terminated and reestablished again.

If this output is TRUE, then the Modbus block is licensed on this CPU. If the
output is FALSE, none or a faulty license string was typed in. You can find
further information in section 4 “Licensing”.

SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems 6-12
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BUSY

NDR_OA, NDR_1A,
NDR_OB, NDR_1B

If this output is TRUE, one of the functions AG_LSEND or AG_LRECYV is
running.

The output is set for each correct executed request of the client via the
corresponding connection.

ERROR_O0A, If this output is set, an error occurred at the corresponding connection when
ERROR_1A, receiving a request or sending a response. The error number is displayed in
ERROR_O0B, the STATUS_x outputs.

ERROR_1B

STATUS_0A, The STATUS_x outputs display the error number when ERROR is TRUE. As

STATUS 1A, long as ERROR is FALSE, STATUS_x displays status information for the

STATUS 0B, corresponding connection.

STATUS_1B
The error numbers and status information are described in chapter
“Diagnostics”.

IDENT_CODE After start-up of the PLC this parameter displays the identification code, an
18 character string. With this IDENT_CODE you can order the registration
key.

You can find further information in section “Licensing”.

RedErrS7 If this output is true, SIMATIC side lost redundancy.

In single-sided redundancy mode the connection of CPO or CP1 is disturbed.
In double-sided redundancy mode both connections of CPO or both
connections of CP1 are disturbed.

You can find further information in section 9.5 “Diagnostics with Alarm
Bits”.

RedErrDev If this output is true, the 3rd party device lost redundancy.

In single-sided redundancy mode the connection from node A to CPO or to
CP1 is disturbed. In double-sided redundancy mode both connections to node
A or both connections to node B are disturbed.

You can find further information in section 9.5 “Diagnostics with Alarm
Bits”.

TotComErr The output TotComErr = TRUE shows a complete communication failure. All
connections are disturbed.

You can find further information in section 9.5 “Diagnostics with Alarm
Bits”.

Init_Error An error during the manual initialization is shown with Init_Error = TRUE.

Init_Status The output Init_Status displays the error number when Init_Error is TRUE.
The error numbers are described in section 9 “Diagnostics”.

SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems 6-13

2XV9450-1MB11; Manual edition 2.2



Function Block MB_REDSV — Modbus Server

6.5 Example for Address Mapping

Interpretation of
Modbus
Addresses

Example:
Parameterization
of the Memory
Areas

Address Mapping

MODBUS bases its data model on a series of tables, which have
distinguishing characteristics. The distinction between these memory areas is
done via the register address by some systems, e.g. MODICON PLCs. So a
MODBUS message requesting the read of a holding register at offset 0 would
return the value known to the application programmer as found in register
40001 (memory type 4xxxx, reference 0001).

One potential source of confusion is the varying interpretation of the register
address in different manuals. Sometimes the register address means the
address of the application layer, sometimes the address transferred.

The FB MB_REDCL uses the Modbus address transferred at its
parameters start_x und START_ADDRESS. So it is possible to use register
addresses from 00004 to FFFF, with each function code.

data_type 1 B#16#3 Holding Register
db_1 W#16#B DB 11

start 1 W#16#1 start address: 0
data_type_ 2 B#16#3 Holding Register
db_2 W#16#C DB 12

start 2 W#16#2D0 start address: 720
data_type_3 B#16#0 not used

db_3 0 0

start 3 0 0

data_type_4 B#16#1 Coils

db_4 W#16#D DB 13

start 4 W#16#2D0 start address: 640

For this example applies:

o DBI11 consists of 1002 byte; 500 registers are mapped (register 0 —
register 499) + 2 reserved byte

o DBI12 consists of 364 byte, 181 register are mapped (register 720 —
register 900) + 2 reserved byte

¢ DB13 consists of 79 byte, 611 bits are mapped (Coil 640 — Coil 1250)
+ 2 reserved byte

The following diagram shows the comparison of the SIMATIC memory area
and the Modbus typical register oriented storage arrangement. The diagram
is based on the above parameterization.

Box Modbus device: The Modbus addresses printed in black refer to the Data
Link Layer, the ones printed in grey refer to the Application Layer.

Box SIMATIC: The SIMATIC addresses printed in black are the offset in the
DB. You can find additionally the Modbus register numbers printed in grey.
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SIMATIC
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6.6 Data and Standard Function used by the FB

Instance DB

Local Variables

Timers
Flags

Standard-FCs for
Data Transfer

SFCs and FCs for
Miscellaneous

The function block MB_REDSYV stores its data in an instance DB. This
instance DB is created by STEP7 at the first call of the FB.

The instance data block contains parameters of type Input, Output,
Input/Output as well as static variables needed for its execution. These
variables are non-volatile and keep its validity between FB calls. The
variables control the internal process flow of the FB.

Required memory of the instance-DBs:
Instance-DB | work memory load memory

MB_REDSV | ca. 4 kByte ca. 5 kByte

The FB requires 96 Bytes of local variables. Additionally the subordinate FBs
require local variables: FBs MB_CPSRV (30 byte) or AG_CNTRL (178 byte).
That gives a maximum of 304 Bytes of local data for a FB MB_REDSVL-call.

The function block does not use any timer.
The function block does not use any flags.

The function block uses the blocks AG_LSEND and AG_LRECYV from the
SIMATIC_NET library for the data transfer between CPU and CP.

The following versions of the FCs are tested with the FB and released for the
communication:

e FC50,AG_LSEND*" Version 3.1
e FC60,AG_LRECV" Version 3.1
e AG_CNTRL" (CP 400) Version 1.0

The FB MB_REDSV uses the following SFCs from the standard library:

Functions e SFB4 ,TON®
e SFC6 ,RD_SINFO*
e SFC20 ,BLKMOV*
e SFC24 ,TEST_DB”
e SFC51 ,RDSYST”
e SFC52 WR_USMSG”
The block MB_CPSRYV uses the following system functions:
e SFB4 ,TON*®
e SFC20 ,BLKMOV*
e SFC24 ,TEST_DB”
SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems 6-16
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Additional Error 8304: When the connection from the CP to the communication partner
Information is interrupted, the interruption is recognized by the CP and error number 8304
stored.

When a communication request is activated, first error code 8304 is returned
even if the connection is available again, because this error code is still
stored. This is a given system characteristics of the CP.

When the MODBUS function block returns ERROR=TRUE and
STATUS=8304, the communication request should be activated once again.

The time delay to recognize the termination of a connection, can be modified
with the parameter “Send Keepalives for Connections” of the CP’s properties
in HW Config.
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6.7 Renaming / Rewiring of Standard Functions and Function Blocks

Inducement Whether you have already used the numbers of standard functions in your
project or the block number is reserved for a different application (e.g. in
CFC), you may rename/rewire the internal called function blocks
AG_LSEND/AG_LRECYV or the blocks MB_REDSV and MB_CPSRV.

It is not possible to rename/rewire the system functions SFC6, SFC20,
SFC24, SFC51 and SFC52 as well as the system function block SFB4.

Sequence You must follow some rules regarding the block numbers when rewiring
blocks in the SIMATIC Manager of STEP7.

If you want to rewire the blocks of the Modbus library, the following sequence
is required:

1. FC50 AG_LSEND
FC60 AG_LRECV

2. FB908 MB_CPCLI
FB906 MB_CPSRV

3. FB909 MB_REDCL
FB907 MB_REDSV

It is not necessary to rewire all blocks. Even if you want to rewire only some
of the blocks, you must follow the mentioned sequence.

Renaming To rewire proceed as described subsequently:

5. Get the information about the used operand by clicking "Extras >
Reference data > Display".

6. Set the operand priority in the object properties of the block folder to
"Absolute value".

7. Call the function "Extras > Re-wire" in the SIMATIC Manager, in
order to re-wire the operands into free areas.

8. To be able to keep on using the symbolism diagnostics tools, add the
modifications in the symbolism table supplementary.

The modifications can be verified by clicking "Extras > Reference data
> Display".
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7 Additional Blocks

7.1 Add-On for CFC

General The add-on offers the possibility to configure Modbus registers/bits in “data
collector FBs” instead of global DBs. The send buffer and receive buffer for
the values can be placed in the CFC chart per Drag & Drop.

Application - The data collector FBs are located in the CFC chart. The output “IDB” is
Sample connected to the DB input db_1, db_2, db_3 or db_4 of the Modbus block.

Then the Modbus values can be connected directly from the channel blocks
to the data collector FB.

&
E_0UT L I_DB35
1 | 1.4
ME_EEDCL REG_@ Wi—
ME_FEEDCL FEC 4 Lif—
z A6#d—W _ id @ _a LICEMSED EOf— REG_2 Wi—
HE _IM _lt A6#2—W _id_d_a EUSY B0 EEG_3 Wi~
deg@—W id G b DOME_BO— EEG_4 Wi—
0 REE_@ | IDE U 1640l id 4 b ERROR BO[— REG 5 |-
w0y REG 4 168#3FF4—(l  loddy coRFTATUS @A VI EEG & Wi~
w0y RER 2 16#3FF5—l_ Jaddr cod$TATUS AR |- EEG 7 W[
#O— EFG F8s—11 chack JATuUs GOF  Wi— EEG ui—
0l REG_4 B—ED u all TATUS 4B W i— EEG_3 Wi—
0 EEG B0 _gFinal DEMT GO0 _SHI— EEG 49 bk
0 REG_#& 16#0—6Y data_tup REG_44 Wi
#0—  REG_7 db 1 EEG_12 Wi—
0 REE_§ 16#1—W  skavt 1 REG 13 Wf—
w0y REE_§ 16#0—BY data_tup. REG 14 Wi~
#0—l REG 40 W db EEG 45 Wi~
0 REG_44 A6#200— W stavt 2 EEG_46  Wj—
a—{y EEG 1 1640 BY dotg tup EEG 1 Wi—
#0—  REG_43 16#0—W _ db_3 REG_45 Wi—
wO—y  EFG 44 A63#E0— tart EEG 13 wi—
aE—{y EEG_15 16#0—6Y data_tup IDE W
w0l REG 16 db ¢
wo—)__REG_47 164250l start ¢
wo—)__RER_1& Gris—{TT MOMITOR
w0—{U_REG_13 0 »—{SN_REG_KEY
B— B0 _EMG
A6#0— B4 DATA THE
46#0—W _ START _AD
16wD0—
@—E0 WEITE_RE|
L IDE U 46#0—{BY UNTT

You can find the additional blocks and a detailed description here:
www.siemens.com/s7modbus or contact the Customer Support.
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7.2 Job List for cyclical telegram transfer

General

Application -
Sample

By means of the block Job_List it is possible to generate a list of jobs, which
are executed cyclically.

1

6
dob_List ,ﬁ
Job_List 401

5511 CYCLICAL SENS B0
B0 DOME QDATA_TYP EY
60 ERROR ASTART_AD W
16#3—EY Job1 _DATA ALENGTH Wl
16#1—|W  Jobd _STAR || GWRITE_RE B0
16#5— W Jobd LENG BUSY BO
©—B0 Jobd WRIT STATUS W
16#4—|BY Job2 DATA
464305—|W__ Job2_STAR
16#2—l  Job? LENG
B—80 Job2 WRIT
16#8—|EY JobG_DATA
16#8—W  Jobd STAR
16#0—|W_ Jobd_LENG
B—(B0 Job3d WRIT
16#8 By Jobd4 DATA
16#0— W Job¢ STRE
16#0—W_ Jobd LENG
©—B0 Job4 WRIT
16#0—|BY Job5_DATA
16#8—W__ Job5_STAE
16#8—  JobS LENE
B0 JobS_WRIT
©—[B0 RESET

IME _REDGL
IME_REDCL
81— id @ _a LICENSED BO
16— id 4 a BUSY BO
16#0—W  id @ b DOME Bl
d680—w  id 4 b ERROE B0
16a3FF0—W_ laddy_cpd || STATUS BA W
16#3FFD—W laddy_cpd | [ STATUS 4R W
5511 check con || STATUS BE W
4—E0 use_all ¢ || STATUS 4B W
@—B0 single wr || IDENT 00D SN
U—E0 Init EedEvyi7 B0
16#5—(BY data_tupe || RedErvDev BO
W db_4 TotComEry B0
68— stave d Init Evro EO
16#4—(BY data_tupe || Init_Stat Wl
W db_2
168200 start 2
16#0—(BY data_tupe
1640 db_3
16#0—W  start 5
1E48—(BY data_tupe
16#0—W_ db_4
d6#0—  start 4
15_208ms—|T1 MOMITOR
“insevt REG_KEY'—|SM REG_KEY
E0_Ehg
EY DATA_TYPE
i SUERT (0D |
LEMGTH
E0 WEITE_RER
16#1—{BY UNIT

You can find the additional block and a detailed description here:
www.siemens.com/s7modbus or contact the Customer Support.
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8 Application with S7-300

General

Usable Modules
for MB_REDCL
und MB_REDSV

Modbus Blocks

The library “Modbus/TCP Redundant” can be used with a S7-300 station as
well.

The description of functions and parameters in the previous and following
sections apply accordingly with S7-300.

Ethernet(1)
Industrial Ethernet

I 1

‘Single—sided (Client)

cp cp
33 |3

‘Dther station(Server1)
[m

CPU P
Js52 |
o !
H @
2 2

Lean

You can only use s7-300 CPUs which provide enough local data per priority
class (=> section 5.6 and section 6.6).

The block AG_CNTRL of the SIMATIC_NET library permits to terminate and
reestablish an established connection. This block was also implemented in
the Modbus blocks for a more effective use of the resources of CPU and CP.
However, previous CPs or previous firmware releases do not support the use
of AG_CNTRL.

Here you can find up-to-date information which CPs and which firmware
releases support AG_CNTRL: Ethernet CPs and AG_CNTRL.

You can find further hardware prerequisites on the internet:
www.siemens.com/s7modbus

The installed library “Modbus_TCP_CP_Red300_400" includes the folders

for S7-300 “S7 300 client” and “S7 300 server” with the blocks for S7-300.
# Modbus_TCP_CP_Red300_400 (Component \!iew).-'—-ci‘i;?xfi:iﬁr m Files' SIEf -10] x|
=@ Modbus_TCP_CP_Red300_400 | Objeot name | Spmbolic na.. | Creste | Type | Mersion
E=E 57 300 Client ZFFBI0S  MB_CPCL SCL Function Black 2.3
e Z3FES1Y  ME_REDCL  5CL FunctionBlack 24
B3R 57 300 Server 3 DB3 LICENSE_DE DB Data Block 01
#-{z1] 57 400 Client
#-{z1] 57 400 Server ; =
Copy the blocks into your project and parameterize the blocks as described in
this manual.
Please make sure to use the blocks AG_CNTRL, AG_SEND and AG_RECV
of the S7-300 library.
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Diagnostics

9 Diagnostics

Diagnostic The diagnostic functions of the CP443 allow you fast failure localization. The
Function following diagnostic features are available:

¢ Diagnostics via the display elements of the CP

¢ Diagnostics via the STATUS output of the modbus function block.
Display Elements The display elements inform you about the operating mode or about the
(LED) failure conditions of the CP. The display elements give you an overview of

internal failures, external failures and interface specific failures.
STATUS Output of For error diagnostics, the FBs MB_REDCL and MB_REDSV respectively
the MODBUS FB have got STATUS outputs. By reading the STATUS outputs you get a

general indication of failures that have occurred during the communication.
The STATUS parameters can be evaluated in the user program.

9.1 Diagnostics via the Display Elements of the CP

Display Functions The display elements of the CP give you information on the module status.
There are two types of display functions:
e  Group Error Displays

- INTF Internal failure
- EXTF External failure

e Special Displays

CP 443-1:
- TXD A telegram is being sent via the interface.
- RXD A telegram is being received via the interface.

A detailed description of the display elements can be found in the device
manual of the CP.
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9.2 Diagnostic Messages of the FBs MB_REDCL and MB_REDSV

Messages at the
STATUS Output of

the FB

Error Messages of
the called SFCs

and FCs

messages.

to STATUS_x without any changes.

The error messages are displayed at the status outputs of the FBs
MB_REDCL and MB_REDSV. Below you will find a list of FB specific error

The Modbus FBs use the standard functions SFC6, SFC20, SFC24, SFC51,
SFC52, FC50 and FC60. The error messages of these blocks are passed on

In the diagnostics buffer or in the online help of SIMATIC Manager you will
find further details on these error messages, as well as in the SIMATIC
STEP7 NCM S7 Industrial Ethernet Manual.

Error messages of FBs MB_REDCL and MB_REDSV

STATUS | Event text Remedy

(Hex)

A002 | An error was detected when checking start_x. Please contact the product

support.

A003 | The DB, to which MODBUS addresses shall be Extend the DB.
mapped, is too short.

Minimum length in byte:

- registers:

(START_ADDRESS —start_x + LENGTH) *2 + 2

- bits

(START_ADDRESS —start_x + LENGTH) / 8 + 2 L

Other possible reasons: CP is client: Correct the

CP is client: Wrong initialization parameter parameters START_ADDRESS
or LENGTH.

CP is server: Wrong address area in the request CP is server: Modify the request

telegram of the client of the client.

A004 | Applies only with CP is client: Correct the parameters. Only
An invalid combination of DATA_TYPE and data type 1 or 3 can be written.
WRITE_READ is given.

A005 | CP is client: An invalid value for the parameter CP is client: Correct the
LENGTH is given. parameter LENGTH.

CP is server: The number of registers or bits in the CP is server: Maodify the number
request telegram is invalid. The CP sends an of registers/bits in the request
exception telegram. telegram.

Range of values:

Read coils/inputs: 1 to 2000

Write coils: 1 to 1968

Read registers: 1 to 125

Write holding registers: 1 to 123

A006 | The given range of data defined with DATA_TYPE, CP is client: Correct the
START_ADDRESS and LENGTH does not exist in parameter’'s combination
data_type_1 to data_type_4. DATA TYPE,

CP is server: The CP sends an exception telegram. START_ADDRESS, LENGTH.
CP is server: Madify the request
of the client or correct the
parameterization of data_type_x.
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STATUS [ Event text Remedy
(Hex)
A007 | CPisclient: An invalid monitoring time MONITOR is | Correct the parameterization.

parameterized.
A value > 20ms is required.

AO008 | Monitoring time MONITOR elapsed when AG_RECV | Verify error messages at the
waits for receipt. E.g. connection is not established. communication partner.
Partner is not ready. Check if the communication
The connection is terminated and reestablished. partner needs a special unit
identifier.
A009 |CPisclient: The received transaction identifier Tl is Verify the data of the
not equal to the sent one. communication partner with the
The connection is terminated and reestablished. help of a telegram trace.
AOOA | CP isclient: The received UNIT is not equal to the Verify the data of the
sent one. communication partner with the
The connection is terminated and reestablished. help of a telegram trace.
AOOB | CP is client: Received function code is not equal to the | CP is client: Verify the data of the
sent one. communication partner with the
help of a telegram trace.
CP is server: An invalid function code was received. CP is server: The Modbus FB
The CP sends an exception telegram. supports the function codes 1, 2,
The connection is terminated and reestablished. 3,4,5,6,15and 16
AOOC | The received byte count does not match the number | Verify the data of the
of registers/bits. communication partner with the
CP is server: The CP sends an exception telegram. help of a telegram trace.
The connection is terminated and reestablished.
AO0OD | Only when CP is client: The register/bit address or the | Verify the data of the
number of registers/bits in the response telegram is communication partner with the
not equal to the one in the request telegram. help of a telegram trace.
AOOE | The length indicated in the MODBUS specific telegram | Verify the data of the
header does not match the number of registers/bits or | communication partner with the
the byte count in the telegram. The FB receives all help of a telegram trace.
data and ignores them.
The connection is terminated and reestablished.
AOOF | A protocol identifier <> 0 was received. Verify the data of the
The connection is terminated and reestablished. communication partner with the
help of a telegram trace.
A010 |Inthe parameterized area db_1 to db_4 a DB number | Correct the parameterization.
is used twice.
AO011 |Aninvalid value for DATA_TYPE is given (Value Correct the parameters.
range: 1 to 4).
A012 | The parameterized areas data_type_1 and Correct the parameterization. The
data_type_2 overlap. data areas must not contain any
overlapping register areas.
A013 | The parameterized areas data_type_1 and ”
data_type_3 overlap.
A014 | The parameterized areas data_type_1 and

data_type_4 overlap.
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STATUS | Event text
(Hex)

Remedy

A019 |0 is assigned to one of the parameters db_x while the

according data_type_x is <> 0.

DB 0 can't be used; it is reserved for system functions.

Correct the parameterization of
db xto>0.

AO1A [ Wrong length in header:
Range of values: 3 to 253 bytes.

The connection is terminated and reestablished.

Verify the data of the
communication partner with the
help of a telegram trace.

A01B CP is server and function code 5:
An invalid value for coils was received.
CP sends an exception telegram.

Verify the data of the
communication partner with the
help of a telegram trace.

AO1E The CP has received invalid data which could not be

assigned.

The connection is terminated and reestablished.

Check the error message of the
communication partner and verify
the data with a telegram trace if
needed.

AO1F |The FB MB_REDCL and MB_REDSYV respectively

have turned to an invalid state.

Please contact the product
support.

A020 Check_conn_cycle is set to < 1s, so no or a too small

cycle time is parameterized for AG_CNTRL.

Correct the parameterization.
Client: With use_all_conn =
TRUE a cycle time > 1s'is
required.

Server: A cycle time > 1sis
required.

A023 | The parameterized areas data_type_2 and
data_type_3 overlap.

Correct the parameterization. The
data areas must not contain any
overlapping register areas.

A024 | The parameterized areas data_type_2 and
data_type_4 overlap.

A034 | The parameterized areas data_type_3 and
data_type_4 overlap.

AO7A | An invalid value id is parameterized. Range of values

is 1 to 64.

Correct the parameterization of
id.

AO07C | Aninvalid value data_type_x was given. The value

range is O to 4.

Correct the parameterization of
data_type_x.

AO07D | Parameter data_type_1 is not defined. The parameter
area _1 is the default area and must be defined.

Correct the parameterization of
data_type 1.

AO7E | The DB number of db_x is identical to the number of

the instance DB.

Correct the parameterization of
db_x.

A080 Different instance DBs were used for the call of

Modbus block in OB100 and the cyclic OB.

Modbus block must be called with
the identical instance DB in
OB100 and the cyclic OB.

A081 | Only if CP is client and function code 5:

The received coil status is not equal to the sent one.

Verify the data of the
communication partner with the
help of a telegram trace.

A082 | Only if CP is client and function code 6:

one.

The received register value is not equal to the sent

Verify the data of the
communication partner with the
help of a telegram trace.
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STATUS [ Event text Remedy
(Hex)
A083 | Only if CP is client: A request was initiated prior to the | Wait with the initiation of a new

completion of the previous one. The request is not
executed.

The manual initialization was started during processing
a telegram.

request until the previous one
was finished either with DONE =
TRUE or ERROR = TRUE.

Wait for the end of the running
job before you start the manual
initialization.

A085 | An error occurred during the license handling due to Verify the project if there is any
an invalid write access. invalid write access to the license
DB. The structure of REG_KEY
must not be changed. Please
contact the Product Support if
necessary.
A090 | The Modbus block is not licensed for this CPU. Read the identification string
This is a status information. The bit ERROR is not set. [ IDENT_CODE for this CPU and
The Modbus communication runs without a license as | order the registration key.
well.
A091 | An exception telegram with exception code 1 was The communication partner does
received (only if CP is client). not support the requested
The connection is terminated and reestablished. function.
A092 | An exception telegram with exception code 2 was Correct LENGTH or
received (only if CP is client). START_ADDRESS at the call of
An attempt to an invalid or non existing address at the |the FB.
communication partner was made.
A093 | An exception telegram with exception code 3 was The communication partner is not
received (only if CP is client). able to execute the received
telegram (e.g. the requested
length is not supported)
A094 | An exception telegram with exception code 4 was The communication partner is in
received (only if CP is client). a state in which it is not able to
execute a received telegram.
AQ095 | An exception telegram with an unknown exception Check the error message of the
code was received (only if CP is client). communication partner and verify
the data with the help of a
telegram trace.
AOFF | The connection is not ready for communication. Check the connections.
Correct the value of
check_conn_cycle if applicable.
This error code is also reported,
when a CP is used, which doesn't
support AG_CNTRL.
FFFF | The connection is not parameterized. If the connection should be used,

id_x and laddr_x must be
parameterized at start-up.
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9.3

Diagnostic Messages of included FCs/SFCs

Error messages of included FCs/SFCs

STATUS [ Event text Remedy

(Hex)

TXXX For detailed information please refer to the online help | See online help (SIMATIC
of SIMATIC Manager. manager -> mark block -> key F1

—> Ethernet -> see also -> code
evaluation )

8XXX For detailed information please refer to the online help | See online help (SIMATIC
of SIMATIC Manager. manager -> mark block -> key F1

—> Ethernet -> see also -> code
evaluation )

80B2 [ The communication bus connection between the CPU | This error may occur once after
and CP is not established. restart of the H-system and can

be ignored.

8186 ID parameter invalid Correct the parameterization. Use
This error code is also reported, when the ID of NetPro and work with
MB_REDCL/MB_REDSV is called with different only 1 instance DB.
instance DBs in cyclical OB and OB100.

9.4 Diagnostic Messages of SFC24

Error messages of SFC24

STATUS [ Event text Remedy
(Hex)
80A1 |[DB Number = 0 or too large for the CPU Choose a valid DB number.
80B1 |The DB does not exist in the CPU. All data blocks that are specified
in DB_x must be created and
copied into the CPU.
80B2 DB UNLINKED DB must not be created as

UNLINKED.
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9.5

Diagnostics with Alarm Bits

The Modbus block provides the possibility to detect lost redundancy. This information is displayed in
the output parameters RedErrS7, RedErrDev and TotComeErr. It is possible to connect these status bits
to an alarm block or to another block for further evaluation.

9.5.1 Client Block

Depending on the parameterizations the alarm bits are set as follows:

1. use all conn = FALSE, check conn_cycle = 0ms

The telegrams are transferred via 1 connection. The other projected connections are on standby.
There is no cyclical check of the connections.

With these parameter settings a check of the connections and the updating of the alarm bits are
only executed, if a telegram is transferred via this connection.
Disturbed or re-established connections on standby can't be recognized.

2. use_all conn = FALSE, check conn cycle > 0s

The telegrams are transferred via 1 connection. The other projected connections are on standby.
When the parameterized time “check_conn_cycle” elapses, a cyclical check of all parameterized
connections is executed.

Nufrgltj)lir/ ! STATUS_OA | STATUS_O0B | STATUS_1A |STATUS_1B | RedErrS7 | RedErrDev | TotComErr
connections

0 0 0 0 0 FALSE FALSE FALSE

0 0 0 <0 FALSE FALSE FALSE

0 0 <0 0 FALSE FALSE FALSE

! 0 <>0 0 0 FALSE FALSE FALSE

<>0 0 0 0 FALSE FALSE FALSE

0 0 <0 <>0 TRUE FALSE FALSE

0 <0 0 <0 FALSE TRUE FALSE

<0 0 0 <0 FALSE FALSE FALSE

? 0 <0 <0 0 FALSE FALSE FALSE

<0 0 <>0 0 FALSE TRUE FALSE

<0 <0 0 0 TRUE FALSE FALSE

<>0 <0 <>0 0 TRUE TRUE FALSE

<0 <0 0 <>0 TRUE TRUE FALSE

3 <>0 0 <0 <>0 TRUE TRUE FALSE

0 <>0 <0 <>0 TRUE TRUE FALSE

4 <>0 <0 <0 <>0 TRUE TRUE TRUE
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3. use all conn =TRUE, check conn_cycle > 0ms, 2 projected connections

The telegrams are transferred via 2 projected connections. When the parameterized time
“check_conn_cycle” elapses, a cyclical check of the connections is executed.

Number of
faulty STATUS OA|STATUS OB |STATUS 1A [STATUS 1B | RedErrS7 | RedErrDev | TotComErr
connections

0 0 FFFF 0 FFFF FALSE FALSE FALSE

0 FFFF <>0 FFFF TRUE TRUE FALSE
! <>0 FFFF 0 FFFF TRUE TRUE FALSE
2 <>0 FFFF <>0 FFFF TRUE TRUE TRUE

4. use all conn = TRUE, check conn_cycle > 0ms, 4 projected connections

The telegrams are transferred via 4 projected connections. When the parameterized time
“check_conn_cycle” elapses, a cyclical check of the connections is executed.

Nufr;]l?lir/ ! STATUS_OA | STATUS_O0B | STATUS_1A |STATUS_1B | RedErrS7 | RedErrDev | TotComErr
connections

0 0 0 0 0 FALSE FALSE FALSE

0 0 0 <>0 FALSE FALSE FALSE

0 0 <>0 0 FALSE FALSE FALSE

! 0 <>0 0 0 FALSE FALSE FALSE

<>0 0 0 0 FALSE FALSE FALSE

0 0 <>0 <>0 TRUE FALSE FALSE

0 <>0 0 <>0 FALSE TRUE FALSE

<>0 0 0 <>0 FALSE FALSE FALSE

2 0 <>0 <>0 0 FALSE FALSE FALSE

<>0 0 <>0 0 FALSE TRUE FALSE

<>0 <>0 0 0 TRUE FALSE FALSE

<>0 <>0 <>0 0 TRUE TRUE FALSE

<>0 <>0 0 <>0 TRUE TRUE FALSE

3 <>0 0 <>0 <>0 TRUE TRUE FALSE

0 <>0 <>0 <>0 TRUE TRUE FALSE

4 <>0 <>0 <>0 <>0 TRUE TRUE TRUE
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9.5.2 Server Block

The time “check_conn_cycle” must be parameterized when using the server block.

Nufr;]l?lir/ ! STATUS_OA | STATUS_OB | STATUS_1A |STATUS_1B | RedErrS7 | RedErrDev | TotComErr
connections
0 0 0 0 0 FALSE FALSE FALSE
0 0 0 <>0 FALSE FALSE FALSE
0 0 <0 0 FALSE FALSE FALSE
! 0 <>0 0 0 FALSE FALSE FALSE
<>0 0 0 0 FALSE FALSE FALSE
0 0 <0 <>0 TRUE FALSE FALSE
0 <0 0 <>0 FALSE TRUE FALSE
<0 0 0 <>0 FALSE FALSE FALSE
? 0 <0 <0 0 FALSE FALSE FALSE
<0 0 <>0 0 FALSE TRUE FALSE
<0 <>0 0 0 TRUE FALSE FALSE
<>0 <0 <>0 0 TRUE TRUE FALSE
<0 <0 0 <>0 TRUE TRUE FALSE
3 <>0 0 <0 <>0 TRUE TRUE FALSE
0 <>0 <0 <0 TRUE TRUE FALSE
4 <>0 <0 <0 <>0 TRUE TRUE TRUE
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10 Application Sample

Sample General With the installation 2 sample projects are stored in \Program
Information Files\Siemens\Step7\Examples.

e sample project “MB_TCP_CP_RED_400" written in STL and
o sample project “MB_TCP_CP_RED_CFC” written in CFC.

The S7 programs are for information purposes only and are not to be
understood as a solution for a customer specific installation configura-

tion.
Example Project On the CD you can find an extensive example project, which offers all
on the CD varieties of parameterization possibilities for the Simatic stations.

e S7-H-Station is client or server

e Single-sided or double-sided redundancy

Ethernet(1) Ethernet{2)
Industrial Ethernet Industrial Ethernet

|

H Single-sided (Client)

T CARIERIETLEN EIREER LD
¥ My
W

=21 P
i Ho
Ho e

H Single-sided {Server)

Crther station(Server1)
z| | B L— ] 7 o
Ho '

TP JCFU 10F L UPLDF
=31 B
o

3
=21

= m m I
20 20 2 20 20 20 2
Ethernet{3) Ethernet{4)
Indusirial Ethernet Indusirial Ethernet

I [ ]I

H Double-sided [Client)
m‘ E:’:‘EDF EIII’IFDF

W
o

H Double-sided [ Server)

Other station(Server2
= B ‘—_ - e Bl e

H

CFU OF MPIDR Bl GRS
iy wrifuae

o
=] H e

CF CF
T3] T3]

o
=] H e

5]

Simatic Stations in The example project consists of the following Simatic stations:
the Example
Project Block / Station Name [ Single-sided | Double-sided | Client Server

H Double-sided (Client) X X

H Double-sided (Server) X X

H Single-sided (Client) X X

H Single-sided (Server) X X
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Programming The programming example consists of the blocks:
Example e Start-Up OB100 with call of FB909 and FB907 respectively
e OB121 programming error

e Cyclic program processing OB1 with call of FB909 and FB907
respectively

¢ Global DBs for job trigger e.g. with variable table and for licensing
o Data blocks for register values and bit values

10.1 Example project in AWL — Modbus Client

Overview Z3MB_TCP_CP_RED_400 (Component view) -- C:\Program Files' 1 EPTiexamples 13l x|
MB_TCP_CP_RED_400 Object narne Symbolic narme Create... I Size ... I Tupe | Wersion
Double-sided [Client] @System data - GDE
j CEUALZAN o 0BT CYCL_EXC 5TL 714 OrgarizatonBlack 01
60 S7Progenll) || g7 RED_FLT sTL 38 Oiganization Block 0.1
""" 3 0B100 COMPLETE RESTART  STL 364 Organization Black 0.1
& Egi;;_:'*‘ Hl o 06121 PROG_ERR STL 38 Organization Block 011
o oP 443101) &3 FB908 MB_CPCLI SCL 9828 Function Block 23
0 H Double-sided (Server) | |2 FB909 MB_REDCL SCL 14554 Function Black 24
& il H Sinlesided (Cient) | & FE10 AG_CHTRL STL 1610 Function 1.0
E H Single-sided [Server] &3 FC50 AG_LSEND STL 846 Function 31
&3 FOROD AG_LRECY STL 952 Function 31
3 D1 CONTROL_DAT DE 102 DataBlock 0.1
303 LICENSE_DE DE 56 DataElock 01
DB Holding Register Area 1 LB 1036 DataBlock 01
FDE12 Holding Register &rea 2 o} 398 DataEBlock 01
L DE13 Cails Area 1 LB 114 DataEBlock 01
£ DES09 IDE_Modbus_Client DE 2084  Instance datablock ... 0.0
'E’ Client_job Client_job - Wariable Table 01
L3 5FE4 TOM STL - System function block 1.0
K I
Used Blocks This block numbers are also used in the provided example project for S7
stations with FB MB_REDCL.
Block Symbol Comment
OB 1 CYCL_EXC Cyclic program processing
OB 100 COMPLETE Start-Up OB for Re-Start
RESTART
OB 121 PROG_ERR Programming error OB
FB 909 MB_REDCL FB MB_REDCL
FB 908 MB_CPCLI Internal called FB MB_CPCLI
DB 1 CONTROL_DAT | Work-DB CONTROL_DAT for FB MB_REDCL
DB 3 LICENSE_DB License-DB for FB MB_REDCL
DB 11 DATA_AREA_1 | DB for memory area 1
DB 12 DATA_AREA_2 | DB for memory area 2
DB 13 DATA_AREA_3 | DB for memory area 3
DB 909 IDB_MODBUS Instance-DB for FB MB_REDCL
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2XV9450-1MB11; Manual edition 2.2



Application Sample

10.2 Example project in AWL — Modbus Server

Overview

Used Blocks

B

E3:MB_TCP_CP_RED_400 (Component view) -- C:\Program Files'S: TE Har * ;Iglzl
MB_TCP_CP_RED_400 Object name Svmbolic narme Create. . I Size .. I Tupe | “ersion
H D ouble-sided [Client] @ Systern data - SDB
il H Double-sided (Server) | |, gy sTL 794 OrganizationBlack 01
LELLA T4 0 0B72 RED_FLT 5TL 3 Owganizalion Block 0.1
e S7Fregramll) g gpep COMPLETE RESTART  STL 430 Orgarization Block. 0.1
C;Lﬁ'l ?_ " I i OB 21 FPROG_ERR 5TL 38 Organization Elock 01
% P 4431 &% FB306 MB_CPSRY SCL 3484  Function Block 22
% CP 4431[1) &3 FBI07 ME_REDSY SCL 11948 Function Block 23
{1 H Single-sided (Cliert) | |82 FC10 AG_CNTRL STL 1610 Function 10
6 [l H Single-sided (Server] | |&% FCE0 AG_LSEND sTL 846 Furction 21
&&F FCED AG_LRECY 5TL 992 Function 31
3 DB COMTROL_DAT DB 100 DataBlock 01
£ DE3 LICEMSE_DE DB 56 DataBlock 01
= DB Holding Register Area 1 DE 1036 DataBlock 01
i DB12 Holding Reqister Area 2 DB 398 DataBlock 01
i DE13 Caoils Area 1 DB 114 DataBlock 01
4k DBA0Y IDB_Modbus_Server DE 2052 Instance datablock ... 0.0
'-‘1=£ Server_job Server_job - Wariable Table 01
& 5FB4 TON STL - System function block 1.0
KN 2l

This block numbers are also used in the provided example project for S7
stations with FB MB_REDCL

Block Symbol Comment

OB 1 CYCL_EXC Cyclic program processing

OB 100 COMPLETE Start-Up OB for Re-Start
RESTART

OB 121 PROG_ERR Programming error OB

FB 907 MB_REDSV FB MB_REDSV

FB 906 MB_CPSRV Internal called FB MB_CPSRV

DB 1 CONTROL_DAT Work-DB CONTROL_DAT for FB MB_REDSV

DB 3 LICENSE_DB License-DB for FB MB_REDSV

DB 11 DATA_AREA_1 Register -DB for memory area 1

DB 12 DATA_AREA_2 Register -DB for memory area 2

DB 13 DATA_AREA_3 Register -DB for memory area 3

DB 907 IDB_MODBUS Instance-DB for FB MB_REDSV

SIMATIC Modbus/TCP Redundant Communication via CP443-1 in H-Systems
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10.3 Example project in CFC — Modbus Client

Overview

The example was created with CFC V7.1 SP2.

i
ME_REDCL
ME_REDCL

ODOME_Counter

2
ME_IK _W
16#0— REG_E IDE
16#0—REG 1
16#0— REG_2
16#0—(REG_3
16#0—EER 4
16#0—REG_5
16#0— REG_§
16#0— EER 7
16#0— REG_&
16#0—REG_3
4
ME_IMN_E
O—EBIT_ & IDE
O—BIT_4
o—EBIT_2
O—EBIT_3
O—BIT 4
O—EIT_5
O—EBIT_&
O—EIT 7
O—EBIT_&
O—|BIT_3
3

ME_0uT

EEG_@

EEG_4

EEG_2

EEG_3

EEG_4

EEG_%

EEG_6&

EEG_7

EEG_&

EEG_3

IDE

"insert REG_KEY"—|EEG_KEY

156#3—DATA_TYF

16#1—STAET _AD

d6#1—|LEMGTH

@—WRITE_RE

16#d—id _B_a LIGEMSED [— cTu
16#3—id_4_a BUSY [— Upwards
d6#2—id_@_b DONE cu [
16#4—id 4 b ERROFE ok [ cy
16#3FFC— 1addy _cp STATUS @ O—s
16#3FF8—|laddr_cp STRTUS 4 dmEa— Py
s chack_co ETATUE @
1—|uze_all STATUS 4
A—zinale_w IDEMT G0 f— ERRORE Counktsr
B—Init RedEvr37[— GTU
18#3— data _tuyp || RedEvyDe[— Upnards
db_1 TotComEr [— cu [
16#1—{start_a Init_Evv[— o—{r [ o
d6#3— data_tup Init_Stal— 0—s
db_2 1@@a— py
164200 start_2
16#8— data_typ
1E#0— db_5 Save_STATUS
16#@—| zkavt_3 Zawve_=THR
16#1— datka_tup
db_% ERROF Save_STH
AG#280— start_4 ETATUE @ Zawe _ETA
1 _ 200ms—|MOMITOF STATUE 4 Savs_3TA
STATUS @ Save ITH
EMG STATUS 4

16#1—|UNIT
a
E_TEIG 0BS5S
Fecognit q.4
CLE || ']

Used Blocks

This block numbers are also used in the provided example project for S7
stations with FB MB_REDCL.

Block Symbol Comment

OB 35 CYCL_EXC Cyclic program processing

OB 100 COMPLETE Start-Up OB for Re-Start
RESTART

OB 121 PROG_ERR Programming error OB

FB 909 MB_REDCL FB MB_REDCL

FB 908 MB_CPCLI Internal called FB MB_CPCLI

FB 900 MB_IN_R Data collector-FB for inputs of real

FB 903 MB_OUT_W Data collector-FB for outputs of word

FB 904 MB_IN_B Data collector-FB for inputs of bool

DB xy DBs, generated by CFC
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10.4 Example project in CFC — Modbus Server

Overview

The example was created with CFC V7.1 SP2.

NOE_@A_Countar ERROE_@A Countar
oy cru
e vevards | ISR
: A
16#0—REG_@ 108 a—k o—g | cul-
1640 —REG_4 a5 o—g
1640 —EEG_2 1 A00@—| Py 1060 —|py
1640 —{REG_3 ME_REDSY
16#0—REG_% ME_REDSW 1.3
1640 —REG_ 46#d—id ©_a LICEMSED— Save STATUS_GOR
1640 —{REG_ 16#3—id 1 a BUSY|— Save STA
160 —{REG_ 16#2—id 0_b MOE_OA
1640 —REG_& 16#4—id 1 b ||EREOR_DA EEROE
16#0—REG_3 16#3FFC—{laddr_cp|[STATUE @ STATUS
16#3FFS—{laddr _cp MODE_4A ST—ETATUS_F
30s—chack_co||EREOE_1A
2 16#3—{dato tup|[STATUS 4 NOE_4A Counter
e _IM_EB db_1 MOE_OB oy EEROE_1A Counter
16#d—ztavt 1 ||ERROR_OB Upwards cTu
o—BIT 0 Inaﬂdata_tgp STATUS @ Upwards ﬂ
O—BIT_4 db_2 MOR_4E 2—R -
o0—EIT_2 16#200—ztavk 2 | |[ERROE_4E o5 o—E [ cu—
o—BIT_3 1640 —{data_tup|[STATUS 4 1oa—{py a5
o—BIT 4 1640 —{db_3 IDENT col— 1m0 —{py
o—BIT_5 1680 —stark & ||RedEves7 [~
0—EIT_& 1680 —{dato_typ|[EedEvyDal—
0—BIT_7 db_4 TekComEr[— Save STATUS_4R
O—BIT _& 164280 —ctave 4 Init Evvi— Save_ZTA
0—BIT_3 ds_2@0ms—|MOMITOR ||Init_Staf—
insevt REG_KEY —|REG_KEY MOE_GB_Countsr
1:1ENR cTU 55
o—{Init Upwards —
-
ok cu -
s
REG_1|— 1m0 —{py
REG 2|
REG_3|—
REG_d4—
REG_5|—
REG_6|—
REG 7|
REG_8|— MOE_1B_Counter ERROE_1B Countar
REG_3|— cTuy cTu
108 Upwards i Upwards ﬂ
o
ok a—g | cyl—
oz a—s
1000 —py 106 —py
Save _STATUS_1B
SGVQ_STRIW
545
EEROE | [Save STA[—
STATUS | [Sawa_sTA|-
s —s1arus Fl
Used Blocks This block numbers are also used in the provided example project for S7
stations with FB MB_REDSV.
Block Symbol Comment

OB 35 CYCL_EXC Cyclic program processing

OB 100 COMPLETE Start-Up OB for Re-Start
RESTART

OB 121 PROG_ERR Programming error OB
FB 907 MB_REDSV FB MB_REDSV
FB 906 MB_CPSRV Internal called FB MB_CPSRV

FB 900 MB_IN_R Data collector-FB for inputs of real
FB 903 MB_OUT_W Data collector-FB for outputs of word
FB 904 MB_IN_B Data collector-FB for inputs of bool

DB xy DBs, generated by CFC
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